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A cash register 
replacement. 

 
Reduce theft. 

 
Reduce inventory 

shrinkage. 
 

Reduce your inventory. 
 

Increase your 
inventory. 

 
Watch your margins. 

 
Speed customer 

checkout. 
 

Greater accuracy. 
 

Keep track of your 
customers. 

Why computerize? 
 
A Cash Register Replacement.  A Computerized Cash Register system 
replaces your old fashioned cash register.  A Cash Register has a single 
purpose.  It tells you how much money your business has taken in during 
the day.  It can tell you that you took in $350, but it can’t tell you how 
much of that money is profit.  It can’t tell you how much inventory you 
have on the shelf.  It can’t tell you how many bottles of soda your 
business sold today.  A computerized cash register can instantly tell you 
that you have $350 in your cash drawer.  It will tell you that $225 of that 
$350 is profit.  It can tell you that you sold 123 bottles of soda today and 
that you still have 246 bottles on the shelf.  It can also tell you what 
items you should order today because your stock is low. 
 
Reduce Theft.  By computerizing, you can reduce theft in your business 
by an average of 2½%.  An average small business doing $500,000 per 
year can reduce in-store theft by an average of $12,500.  How?  Your 
employees become more involved in watching the store inventory if they 
know that every piece of inventory in your business is being monitored. 
 
Reduce Inventory Shrinkage.  By watching your inventory and 
comparing on shelf inventory to your computerized reports, both you 
and your employees are much more careful about giving away inventory, 
retaining obsolete inventory, monitoring breakage and non-theft 
inventory that “walks” out of your business, as well as checking 
inventory as the items enter your store.  You can reduce inventory 
shrinkage by up to another 2½% by computerizing. 
 
Reduce Your Inventory.  By watching your inventory reports, you can 
make sure that you order more wisely.  You don’t need 150 snow 
shovels on the shelf in the summer. 
 
Increase Your Inventory.  You don’t need 150 snow shovels in the 
summer, but you may need 500 more batteries for your store during the 
month of August.  Many stores order products based on what they think 
they sell.  If you check your inventory reports and see that you sold 500 
batteries last August, it gives you a good clue to help make sure that you 
don’t run out of batteries this August.  Watching your inventory reports 
increases your efficiency. 
 
Watch Your Margins. By reading your reports you may find that you 
sell 10,000 batteries that cost 48 cents for 50 cents each and that you sell 
100 flashlights that cost $1.98 for $9.95 each.  Your inventory reports 
will help you to stock more products that give you greater profits and 
fewer products that give you the least amount of profit. 
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On average, 
computerizing will 

save you 5% of your 
sales. 

 
A business doing 

$500,000 per year in 
sales will save $25,000 

per year by 
computerizing. 

 
A typical single station 
computer system with 

printer, cash drawer, 
computer, and scanner 

costs approximately 
$2.10 per day on 

average. 
 

The typical computer 
system above will save 

you $83.33 per day on 
average! 

Speed Customer Checkout.  Computerizing speeds up your customer 
checkout.  With a barcode scanner, you can checkout a customer in half 
the time required with a cash register.  Even if you don’t use a barcode 
scanner, your checkout is still faster and more accurate because you are 
entering inventory item numbers that are automatically tied to pricing 
specified in Cash Register Express for each inventory item. 
 
Accuracy.  Every item in your store has a price associated with it.  
Never again will you have to figure out how much that flashlight sells 
for.  Your clerks will stop guessing those prices. 
 
Keep Track of Your Customers.  Your best customers are your present 
customers. No matter what type of store you have, you should try to 
obtain the name and address of every one of your customers.  Keeping a 
customer list is an obvious asset for a clothing store.  You want your 
customers to keep coming back, especially when you have a sale.  The 
importance of keeping a customer list is less obvious in a hardware 
store, but extremely important.  Mailing to your customers periodically 
keeps them coming back.  Your vendors may even help you pay for the 
cost of the mailing.  Mailing to your customers is the best form of 
advertising – even if it is just a quick postcard listing a few new sale 
items.  Every mailing to your customer list will always be a positive to 
your cash flow.  What about a store such as a convenience store?  You 
don’t have to get the name and address of every customer that walks into 
the store, but you should get the names and addresses of your best 
customers. 
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Installation Notes 
 

1.  Make sure you have the necessary computer hardware to run Cash Register Express: 
 
 Minimum Requirements: 
 

? ? PC with Pentium processor or better, 64 megs of RAM or better 
? ? CD-ROM (3.5” floppy drive recommended for backing up your database) 
? ? Microsoft? Windows 95, Windows NT 3.5 or higher 
 
Suggested Setup: 
 
? ? PC with Pentium III processor, 128 megs of RAM or better 
? ? CD-ROM (3.5” floppy drive recommended for backing up your database) 
? ? Microsoft? Windows 95, Windows NT 3.5 or higher 
 
 

2.  Network Installation: If you are on a network of any kind, it is recommended that you place the 
CRE2000.mdb database file (this may be referred to as the CRE database file in the manual) on the 
server drive and install the actual program on the workstations.  Running both the program and the 
database file across the network will slow the program down considerably and may result in errors or 
unstable performance.  See “Installation Procedures” for further information. 

 
3.  OS/2-DOS Swap: If you are running OS/2 and DOS on one computer, it is highly recommended that 

you do not run CRE under the Win/OS2 emulator, but rather use Windows on the DOS operating 
system.  Using the Win/OS2 emulator will result in errors. 
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Installation Procedures 
CD-ROM with Autostart 
1. Insert the CRE installation CD in the CD-ROM, wait for Internet Explorer menu to start. 
 
2. Choose “Click Here to Install Cash Register Express (CRE 2001 or RPE 2001)” 
 
3. Click Run from Current Location. 
 
4. Choose Yes when it asks if you wish to install Setup.exe 

 
CD-ROM without Autostart 

 
1.  Insert the CRE installation CD in the CD-ROM, click on Start, and then select Run from the Start 

Menu. 
 

2.  Type D:\SETUP (or the CD-ROM drive followed by \SETUP) and click on the OK button.  Follow 
the on-screen instructions. 

 
3.  To run CRE, select Cash Register Express for Windows ’95 from the CRE2000 folder in the Start 

Menu.  The first time that you execute CRE you will be asked to specify the following:  
   

? ? The location where you wish your CRE database to reside: If you plan to work in a 
network environment with multiple computers executing CRE and sharing the same 
database, you will want to specify a network drive.  You should install CRE on each 
computer and then specify the same location for the database.  You may override your 
specifications by selecting the Setup menu from the CRE ID screen.  If you encounter 
problems with your initial specifications, delete the file CRESETUP.PCA from the 
directory where you installed CRE – you will be asked to specify your file locations before 
CRE executes as if it were the first time executing the program 

 
? ? The location of your Windows Drive: This could be different than the drive you specified 

for CRE installation during Setup. 
 

? ? The location of the IC Verify Communication File: If you are not using IC VERIFY, you 
must still specify a location or accept the location shown.  
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Backing Up Your Data 
 

It is recommended that you backup your CRE database file every day.  The best way to backup your data is 
to back it up onto a 3.5” floppy diskette.  However, you may also backup your data file to a remote 
directory in the root drive (C:\). 
 
To backup your data onto a 3.5” floppy diskette in DOS: 
 

1.  Go to the DOS prompt (C:\>) 
 
2.  Type CD\CRE2000\DATA2000 and press <ENTER>.  This will take you to the 

DATA2000 subdirectory.  This is where your database file is located.  It is called 
CRE2000.mdb. 

 
3.  Insert a 3.5” floppy diskette in the floppy drive. 
 
4.  Type COPY CRE2000.MDB A: (or B: depending on the floppy drive) and press 

<ENTER>.  Wait for the message “1 file copied”. 
 
To backup your data onto a 3.5” floppy diskette in Windows: 
 

1.  Click on the Start menu and select Run. 
 
2.  Type C:\CRE2000\DATA2000 and press <ENTER>. 
 
3.  Insert a 3.5” floppy diskette into the floppy drive, then click on the Start menu and select 

Run. 
 
4.  Type A:\ (or B:\ depending on the floppy drive). 
 
5.  Click on the icon named CRE2000 (this is your database file) in the data window and drag it 

into the floppy diskette window.  The same icon and file will appear in the floppy disk 
window. 

 
At some point, your database file might become too large to fit onto a 3.5” floppy diskette.  You can use 
WINZIP, a file compression utility that shrinks or “zips” files so that they can fit onto a diskette.  It is a 
shareware utility that can be downloaded from the Internet.  You can download WINZIP from the 
download page on the PC America homepage.  The address is http://www.pcamerica.com. 
 
To backup your data onto a remote directory using DOS: 
 

1.  Go to the DOS prompt and make sure you are in the root directory (C:\). 
 
2.  Make a new directory to which you can copy your database file on the C: drive.  We 

recommend calling this new directory CREBAK.  To make this new directory, type MD 
CREBAK, then press <ENTER>.   

 
3.  Type CD\CRE2000\DATA2000, then press <ENTER>.  This will take you to the 

DATA2000 subdirectory where your database file is located. 
 
4.  Type COPY CRE2000.MDB C:\CREBAK, then press <ENTER>.  Wait for the message 

“1 file copied”. 
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To backup your data onto a remote directory using Windows: 
 

1.  Create a new directory on the C: drive called CREBAK.  To do this, click on the Start 
menu and select Run.  Type C:\.  Right-click on the open window and select New then 
Folder from the menu.  Type CREBAK, then press <ENTER>. 

 
2.  Next, open the window containing the CRE database file.  Click on the Start menu and 

select Run.  Type C:\CRE2000\DATA2000.   
 
3.  Open the CREBAK directory that you just created. 
 
4.  Click on the file called CRE2000 in the DATA2000 directory (this is your CRE database 

file) and drag it into the CREBAK window.  The same icon and file will appear in the new 
directory. 
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Log-in Screen 
 

 
 

The first screen that appears when you run Cash Register Express is the Log-in Screen.  To log in to Cash 
Register Express, type in the password for the shown cashier ID, then press <ENTER> or click on Login.  
To log in as the administrator, type in the administrator password under any Cashier ID.  To log in as a 
cashier under a different cashier ID, type in the desired ID in the Cashier ID field, then enter that 
cashier’s password.  You may only change Cashier IDs if you have manually added in the ID through the 
File menu.  This option is enabled in both the single and multi-user versions. The multi-user version of 
CRE allows for multiple cash register stations.  When logging in, enter in your station ID as well as your 
cashier ID and password.  You may only change Station IDs if you have a registered multi-user version of 
CRE and you have manually added in the Station ID through Add Station in the File menu. 
 

The default Administrator Password is: Admin 
 

The default Cashier Password is: Cashier 
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File Menu 
 

The File menu on the Cash Register Express Log-in Screen allows you to redefine your original 
specifications for the location of your CRE database, Windows directory, and IC VERIFY interface file, as 
well as compact and repair, check, backup, and clear your database.  This menu also allows you to enter 
the network password to have multiple cash register stations, change your current password, define the 
functions allowed for cashiers, and maintain employee information.  To access the File menu, click on 
File or press <ALT- F>. 
 

 
 

 
 
 

 

Select Industry 

 
 
This function allows you to choose which program to load upon start up.  To choose Cash Register 
Express, enter 1 for General Retail, or enter 2 for Restaurant Pro Express. 
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Select Database Location 
 

This allows you to specify your CRE Database, Windows drive, and IC VERIFY locations (If you are not 
using IC VERIFY, you must still specify a location for the file).  You will also be prompted to choose 
which program to load on startup (CRE 2000 or Restaurant Pro Express). 
 
NOTE: This example shows the database location to be on the c:\ drive.  If the database is being 
shared on the network, you must specify the drive letter of the shared drive (e:\ for example). 
 
 

 
 

 
 

 
 
To make changes in the Setup File Locations Screen: 
 

? ? Choose Select DB Location from the File menu. 
 

? ? Click on OK or press <ENTER> to keep the current location, or type in the desired location 
then press <ENTER> to save the changes. 

 
? ? Repeat the previous step for Windows Drive and IC Verify Drive 

 
? ? Choose which program to load upon startup.  Press 1 for CRE 2000 or 2 for Restaurant Pro 

Express. 
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Compact and Repair Database 
 

You should select this function to repair a database that was left invalid by an incomplete write operation.  
This can occur if CRE quits unexpectedly because of a power outage or a computer hardware problem.  
This function also attempts to validate all system tables and all indexes. You should also select this 
function after numerous additions and updates have been made to your CRE database.  As you change 
data in a database, the file can become fragmented and use more disk space than necessary.  Periodically, 
you should compact your database in order to defragment the file.  The compacted database will usually be 
smaller. To compact or repair your database, select Compact and Repair DB from the File menu. 
 
NOTE: A backup of the original database is created before compacting.  It is called CRE32CMP.MDB 
and will be stored in the C:\CRE2000\DATA2000 directory. 

 
 

Check Database 
 

This function allows you to check your database for inconsistencies and data entry errors within the 
database.  You will be given the option to backup your database before proceeding.  It is recommended 
that you make a backup before checking the database.  To check your database, select Check DB from 
the File menu. 

 
 

Clear Database 
 

This feature lets you delete all of the previous transactions that were performed with Cash Register 
Express.  It will not delete any other data such as customers, inventory, etc.  If you need to delete 
everything from your database, it would be best to re-install CRE.  To clear all transactions from your 
database, select Clear DB from the File menu.  Once you delete the transactions, there is no way to 
recover them, so it is recommended to backup your database file before using this feature. 
 
WARNING: Be sure to balance all customers on account to zero prior to clearing the transactions.  
Clearing all transactions from the database includes transactions that are processed on account. 
 
NOTE: The invoice number counter will be reset as well.  The next invoice you create will be assigned 
the number 1001. 

 
 

Backup Database 
 

To backup and compact your database, select Backup DB from the File menu. 
 
TIP: For the ultimate source of protection, you should backup your database file to a floppy 
diskette(s). 
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Add Station 
 

To add a Station ID: 
 

? ? Click on File or press <ALT-F>, then select Add Station. 
 

? ? Enter the new Station ID in the Station ID field. 
 

? ? Click on OK or press <ENTER> to save the new ID.  If the Station ID already exists, CRE 
will display a message prompting you to choose a new Station ID.  Click on Cancel to exit 
without adding a new Station ID. 

 
 
 
 
 

Employee Maintenance 
 

This screen allows you to create or update a cashier ID.  To use this function, select Employee 
Maintenance from the File menu. 
 
To add a Cashier ID: 
 

? ? Click on File or press <ALT-F>, then select Employee Maintenance.  You will be 
prompted to enter the administrator’s password. 

 
? ? Click on Add or press <ALT-A>. 

 
? ? Enter the new Cashier ID and the employee’s information.  When you are finished, click on 

Done or press <ALT-D>.  To quit without adding a Cashier ID, click on Cancel or press 
<ALT-C>.   

 
NOTE:  Cashier IDs must be two characters long. 

 
 
To update a Cashier ID: 
 

? ? Click on File or press <ALT-F>, then select Employee Maintenance.  You will be 
prompted to enter the administrator’s password. 

 
? ? Change the desired fields, then click on Update or press <ALT-U> to save your changes.  

Click on Exit or press <ALT-X> to quit without saving. 
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General 

 
 
This screen displays the general information for a Cashier ID.  To access this screen, click on the General 
tab or press <ALT-G>. 
 
Employee Department: Use this list of departments to classify your employees.  To select a department, 
click on its name.  For more information on creating employee departments, see Chapter2: Inventory 
Control: Departments. 
 
Password: This is the password for the displayed employee.  The default password for new cashiers is 
Cashier.  To change the password for a cashier, type the new password in this field, click on Update.  
You may also change this password by selecting Change Passwords in the File menu. 
 
CashierID: This is the current Cashier ID.  To select a different Cashier ID, use the Next and Previous 
buttons or click on the Cashier ID button, enter the desired two digit ID, then press <ENTER> or click 
on OK. 
 
Associated Customer #: If the employee has a customer number, enter it here by clicking on the 
Associated Customer # button, finding the correct Customer Number, then clicking Add.  The default 
Customer Number is 101. 
 
Card Swipe ID: This is the value encoded on the employee’s ID card.  Use this for quick logon/logout. 
 
Hourly Wage: This is how much the employee is paid per hour. 
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Permissions 

 
 
This screen allows you to specify which functions a certain cashier can use.  To access this screen, click 
on the Permissions tab or press <ALT-P>.  Each function has four choices:  Yes, No, Prompt, and 
Override. 
 

Yes:   Allows the employee access to that function 
No:  Does not allow the employee access to that function 
Prompt: Prompts the administrator to enter his/her password on the fly so the cashier 

can perform the desired function. 
Override: Allows any cashier that has permission to perform this function to enter his/her 

ID and password on the fly.  For example, if Cashier 01 has Void Invoices set 
to Prompt but needs to void an invoice, Cashier 02, who has Void Invoices set 
to Override, can enter his/her ID and password to void the invoice that one 
time, or the administrator can enter his/her own password. 
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Functionality 
 
This screen displays the general functions that the selected employee has access to.  To access this screen, 
click on Functionality or press <ALT-F> while in the Permissions screen. 
 
Invoice Discounts: Allows the employee to perform invoice discounts. 
 
Invoice Price Changes: Allows the employee to change the price of an item entered on the invoice 
screen. 
 
Invoice Item Deletion: Allows the employee to delete an item from an invoice. 
 
Void Invoices: Allows the employee to void an invoice. 
 
Accounting Interface: Allows the employee to perform the QuickBooks Sales Totals Pass in the Sales 
Information menu.  For more information, see Chapter 5: Sales Information and Reports. 
 
Allow Exit from CRE: Allows the employee to exit from CRE. 
 
Returns: Allows the employee to enter returned items. 
 
 
Reports 
 
This screen controls what reporting functions the selected employee has access to.  To access this screen, 
click on Reports or press <ALT-R> while in the Permissions screen. 
 
Display Reports: Allows the employee to display reports. 
 
Print Reports: Allows the employee to print reports. 
 
Print DDR: Allows the employee to print the Detailed Daily Report. 
 
 
Setup 
 
This screen controls which software and hardware settings selected employee can modify.  To access this 
screen, click on Setup or press <ALT-U> while in the Permissions screen. 
 
Company Info:  Allows the employee to modify the Company Info in the Setup Screen. 
 
Tax Rates: Allows the employee to modify the tax rates. 
 
Bonus Plan:  Allows the employee to modify the Bonus Plan settings. 
 
Accounting Info:  Allows the employee to modify settings in the QuickBooks Setup. 
 
Discount Levels: Allows the employee to modify the discount levels set in the Setup Screen. 
 
Display Settings: Allows the employee to modify the display settings for that station. 
 
Default Printer: Allows the employee to modify the default printer for that station. 
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Inventory 
 
This screen determines how much control the selected employee has over your inventory information.  To 
access this screen, click on Inventory or press <ALT-I> while in the Permissions screen. 
 
Add Inventory/Kits: Allows the employee to add items or kits to your inventory. 
 
Update Inventory/Kits: Allows the employee to update information on items or kits in your inventory. 
 
Add Vendor: Allows the employee to add a vendor. 
 
Update Vendor:  Allows the employee to update information about a vendor. 
 
Add Department: Allows the employee to add a department. 
 
Update Department: Allows the employee to update information about a department. 
 
Print Extra Ticket/Voucher: Allows the employee to print additional tickets or vouchers for an item.  
See Chapter 2: Inventory Control: Inventory Maintenance for more information on tickets and 
vouchers. 
 
 
Customer 
 
This screen determines how much control the selected employee has over your customer information.  To 
access this screen, click on Customer or press <ALT-C> while in the Permissions screen. 
 
Add Customers: Allows the employee to add a new customer. 
 
Edit Customers: Allows the employee to update information on a customer. 
 
Display Balances: Allows the employee to view the customer’s On Account balance. 
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Change Passwords 
 

The default Administrator Password is: Admin 
The default Cashier Password is: Cashier 
 
This section allows you to change a password for a cashier or the administrator.  To access this screen, 
select Change Passwords from the Log-in Screen File menu. 
 

 
To change a Cashier Password 
 

? ? Type the Cashier ID for which the password will be changed in the Cashier ID field. 
 

? ? Type the current password, or the administrator’s password if the cashier forgets his, in the 
Old Password or Administrator Password field. 

 
? ? Type the new password to be used by this cashier in the New Password field. 
 
? ? Re-enter the new password in the Verify New Password field to ensure no errors in typing. 
 
? ? Click on Update to store the new password. 

To change the Administrator Password: 
 

? ? Type the current administrator password in the Old Password field (If you forget the 
administrator password, contact PC America). 

 
? ? Type the new password in the New Password field. 

 
? ? Re-enter the new password in the Verify New Password field to ensure no errors were made 

in typing, and then click on Update to store the new password. 
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Setup Screen 
 

 
Click on the appropriate tab to select which settings to change. 

 
The Setup Screen allows you to customize Cash Register Express with your computer system setup.  To 
view the Setup Screen, select Setup Screen from the File menu (from the traditional screen) or click 
Options, Setup then Setup Menu (from the modern screen).  Each of the different settings is fully 
explained in the following paragraphs.  Click on Update to save your changes or click on Exit to ignore 
all changes. 
 
 
Hardware 
 
Use this option to specify the location of your cash drawer, pole display, and PD-1 ECR Scale.  To change 
any of these settings, click on the Hardware tab in the Setup Screen, and then click on the appropriate 
port setting.   
 
Pole Display Port: Cash Register Express will display invoice items, associated prices, and a running 
total on a pole display as items are added to an invoice.  Pole Display should be set to “None” if you do 
not have a display.  If you do have a display, you must specify the COM port to which it is attached - 
COM1, COM2, COM3, or COM4.  If Pole Display is not set to “None”, a clock will appear in the bottom 
right hand corner of the screen.  Clicking on this clock icon will display the current time on the pole 
display. 
 
You must make sure the appropriate COM port is recognized and enabled in the Device Manager of the 
Windows Control Panel.  The port settings should match the settings as described in the Pole Display 
Manual.  (For example, Baud or Bits per Second = 9600, Parity = None, Data bits = 8, Stop bits = 2) 
 
If your pole display is not functioning properly, try the pole display test listed in the appendix. 
 
Cash Drawer Port: Use this option to specify the location of your cash drawer.  Cash Drawer Port 
should be set to “None” if you do not have a cash drawer.  If you do have a cash drawer, you must specify 
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its location - COM1, COM2, COM3, COM4, LPT1, LPT2, LPT3, or LPT4.  If your cash drawer receives 
its power from the receipt printer, you should set your cash drawer port to the same port as the receipt 
printer. 
 
PD-1 ECR Interface Scale: CRE will draw a weight from the PD-1 ECR Interface Scale and use it as a 
quantity.  PD-1 ECR Interface Scale should be set to “None” if you do not have this scale.  If you do 
have this scale, you must specify the COM port to which it is attached.  A button with a “W” will appear 
next to the quantity box after choosing a port. 
 

 
 
To retrieve the weight, click on this button and then proceed with the invoice as if it were a normal 
quantity. 
 
Pole Display Type: Use this option to select what type of Pole Display you are using.  Click on General 
for a general pole display or click on Casio for a Casio SA-5100 Pole Display. 
 
 
Touch Screen 
 
Department Selection: When this option is enabled, only the departments will be displayed in Touch 
Screen Invoicing, not the entire inventory.  To display all the items under a certain department, touch the 
corresponding button.  When department selection is disabled, the entire inventory will be displayed.  
Displaying only departments helps keep your Touch Screen more organized.  To change your settings for 
this feature, click on the Touch Screen tab in the Setup Screen, and then click on YES to enable 
department selection or NO to disable it. 
 
Display Modifier Items: When this is option enabled, all of the different modifiers for preparing an item 
are displayed in Touch Screen invoicing.  You may wish to disable this option if you want to minimize the 
number of items displayed in Touch Screen invoicing.  To change your settings for this feature, click on 
the Touch Screen tab in the Setup Screen, then click on YES to display modifier items or NO to only 
show the regular inventory. 
 
Use Decimals in Numeric Entries: Disable this option if you do not want to hit the decimal button for 
numeric amounts.  For example, 1 2 5 will register as $1.25, not $125. 
 
 
Printer Setup 
 
This screen allows you to select the types of printer you will use with Cash Register Express.  To change 
your printer type, click on the Printer Setup tab in the Setup Screen.  Next, select the type of printer you 
have for receipts and reports - Receipt printer, Laser Printer/HP DeskJet, Epson Receipt Printers, Epson 
TMU 295, or SCP 700 - by clicking on that name or circle.  Choose Laser Printer/HP DeskJet for all 
laser printers, bubble jet printers, and ink jet printers.  In addition, if you have a Monarch 9820 printer, 
select a port for the Monarch Ticket Printer and/or the Monarch Voucher Printer.  If you are using an 
Epson TM 300 or a Barcode Blaster, chose a port for these printers as well. 
 
 
Credit Card Processing 
 
Cash Register Express allows you to process credit card transactions either manually or via the IC 
VERIFY credit card processing software system.  Express Manual Processing allows you to record an 
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invoice as a credit card purchase without having to enter the credit card information.  The credit card type 
will be recorded as "None".  To change how you process your credit card transactions, click on the CC 
Processing tab in the Setup Screen, then select the option you wish to use for credit card processing.  If 
you are using IC VERIFY, see Chapter 7: Using IC VERIFY with Cash Register Express. 
Additional CC Types: This feature allows you to define your own credit card types in CRE 2000, such as 
American Express.  The credit ID may only have four characters.  These credit card types can only be 
used in manual processing.  To enter an additional credit card type, click on +, enter the desired four 
character ID, then click on OK or press <ENTER>. 
 
 
Invoice Settings 
 
Prompt Cashier ID - When this feature is enabled, the cashier is prompted to enter his Cashier ID or 
swipe their ID card upon completion of a transaction.  This option may be useful if numerous cashiers are 
ringing up people on the same machine.  To change your settings for this feature, click on the Invoice 
Settings tab in the Setup Screen.  Click on YES to enable this feature or click on NO to disable it. 
 
Combine Lines – When this function is enabled, multiple entries for the same item will be combined on 
one line.  For example, if Hamburger, French Fries, then Hamburger are entered, the screen and receipt 
will show Hamburger 2 @ Price, French Fries 1 @ Price instead of Hamburger 1 @ Price, French Fries 1 
@ Price, Hamburger 1 @ Price. 
 
Default Payment Type: This option allows you to automatically set the default payment type to “on 
account” when you select a customer. 
 
Stock Prompt: When this option is disabled, CRE will no longer prompt for backorders if an item is not 
in stock. 
 
Prompt Salesperson: When this option is enabled, you will be prompted to enter a salesperson ID at the 
end of an invoice.  This allows you to track one person getting credit for a sale and another ringing it up 
on the register.  NOTE: Salespeople must be set up as cashiers for this option.  When prompted, 
enter the salesperson’s Cashier ID or swipe the employee’s ID card. 
 
Last Price Lookup: When this option is enabled, a customer will automatically be rung up at the last 
price they paid for an item.  For example, if an item is normally priced at $10.00 but you sell it to a 
customer for $9.00, the customer will be rung up automatically at $9.00 the next time they purchase that 
item. 
 
Round Invoice: If this option is enabled, all extended line totals will be rounded to the nearest $0.05, 
$0.10, or $1.00, depending on your selection.  This is useful if your tax is built into your price so you 
won’t have to deal with pennies. 
 
Prompt Amount Tendered: Disable this option if you don’t want CRE to prompt you to enter the amount 
tendered.  This is useful if you want to eliminate a few keystrokes by doing the math in your head. 
 
Idle Log Out: Use this option to automatically log out after a certain amount of time of being idle. 
 
Prompt Zip Code:  If this option is enabled, you will be prompted to enter a zip code at the end of each 
invoice.  You can then run a report to see how many sales were processed in each zip code, therefore 
generating regional sales figures (see Chapter 5: Reports: Sales Reports).  This information is useful for 
advertising budgeting. 
 
 
 



 

Cash Register Express 21

Inventory 
 
Auto Cost Percentage for Non-Inventory Items - This feature automatically calculates the cost of a non-
inventory item based on the price entered in the Non-Inventory Item screen.  For example, suppose the 
cost percentage is set for YES and 33%.  If you add a non-inventory item to the invoice and enter a price 
of $5.00, CRE will automatically calculate the cost as $1.65.  If you set this option to NO, the cost will be 
whatever you enter it as.  To change your settings for Auto Cost Percentage, click on the Inventory tab in 
the Setup Screen. 
 
Average Cost Method - If you receive an item into stock at a new cost, CRE 2000 will automatically 
change the cost of this item to the average cost you have paid if this feature is enabled.  This method is 
used when receiving stock from instant purchase orders through the Inventory Maintenance screen and 
also within the main Purchase Orders screen.  To enable the Average Cost Method, click on the circle 
next to Enabled on the Invoice Tab of the Setup Screen. 
 
 
Company Information 
 

 
 
This is the name, address, and telephone number that will appear on every invoice, receipt, report, or 
statement.  PC America’s company information is the default company name, address, and phone number.  
To enter your own company information, click on the Company Info tab in the Setup Screen.  Use 
<TAB> to move from field to field, and then replace the old company information with the desired 
company information.  Click on Update to store the new company information.  You must enter 
information on all four lines. 
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Account Control 
 
Deadbeat Control: 
 

 
 
When this feature is enabled, a screen will appear listing all the items that are currently rented by the 
customer when you pull up his account.  To change the settings for deadbeat control, click on the Account 
Control tab in the Setup Screen, then click on Enabled or Disabled. 
 
Max Balances: This feature allows you to set a maximum balance for on account customers.  When 
enabled, customers will not be able to charge any amount on their account greater than their maximum 
balance. 
 
Referral Source:  This feature allows you to record where a customer heard about your company and 
report on it (see Chapter 5: Reports: Reporting Screen: Customer Reports for more information on 
this report).  To add a referral source type, click on + and enter the desired four character ID (ex: EMIL 
for e-mail).  Next, enter the customer reference description (ex: Magazine).  For more information on 
recording a customer’s referral source, see Chapter 3: Customer Maintenance. 
 
Restaurant Features 
 
Print Tip Line on Credit Card Invoices: When this function is enabled, a line to enter a tip amount will 
print on credit card invoices.  This option allows customers to put the tip on their credit card as well as the 
entire invoice.  To change your settings for this feature, click on the Restaurant Features tab in the Setup 
Screen.  Click on YES to enable this feature or click on NO to disable it. 
 
Auto Tipping: This feature will automatically apply a tip to parties over a specified size if you are using 
touch screen invoicing.  When you choose “$$$” from the touch screen for a party larger than the set 
limit, you will be asked if you want to add the specified percentage to the order as a tip.  To change your 
settings for this feature, click on the Restaurant Features tab in the Setup Screen.  NOTE: Enter the 
percentage as an integer.  For example, enter 15 for 15%. 
 

Prompt Table #: If this option is enabled and prompt Cashier ID is disabled, you will only be prompted 
to enter the table number.  This allows for faster invoicing in instances where cashier tracking is not 
necessary. 
 
Print Modifiers on Receipt: Enable this option to print modifiers for an item on the receipt. 
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Internet Features 
 
File Transfer E-mail Address: Invoice export files created through the ASCII Transfer screen can be 
automatically e-mailed to the e-mail address specified here.  For more information on creating an invoice 
export file, see Chapter 6: CRE Tools: ASCII Transfer.  See Chapter 6: CRE Tools: Send to Host for 
more information on sending export files. 
 
NOTE:  You must have a MAPI Compatible e-mail client installed and set up to send and receive  
e-mails. 
 
 
Receipt 
 
Receipt Size: Use this option to select the paper size to be used for invoice receipts from the following 
selections: Receipt, Full, Full Professional, or NEBS 9245-4.  To change your receipt paper size, click 
on the Receipt tab in the Setup Screen.  Full Professional is designed to print on a standard laser printer. 
 
If you select Full Professional, the Prof Logo option is displayed.  You may choose to include a picture, 
company info, or both a picture and company info on the receipt.  NOTE: The selected picture must be 
a .jpg or .gif file. 
 
If you select Receipt and your receipt printer is defined as Generic under Windows, use the Windows 
printer setup option to indicate No Page Breaks to ensure that the printer will not eject a full page when 
each receipt is printed.  CRE automatically prints a few blank lines to allow tearing between receipts. 
 
If you select NEBS 9245-4, you must set the paper size as User Defined in the Windows printer setting. 
 
Print Invoices: Use this option to indicate whether invoices should print automatically or if you should be 
prompted to print each invoice.  To change your Print Invoice settings, click on the Receipt tab in the 
Setup Screen.  Select YES to automatically print out an invoice upon completion of a transaction.  Select 
NO if you don’t want invoices to print at all.  Select PROMPT if you only want invoices to be printed at 
certain times.  You will be prompted to print an invoice each time you end a transaction.  Select CC Only 
to only print a receipt for credit card invoices. 
 
Display Equals: If you select Yes for this feature, the line of equal signs separating the items from the 
rest of the receipt will print. 
 
Print Amount Saved: Enable this option to print the total difference between your selling price and the 
retail price for the invoice.  This is for non-NEBS receipts. 
 
Validate Checks:  When this function is enabled, the invoice number, date and grand total will print on 
the back of checks.  You can only use this function if you have an Ithaca slip printer. 
 
Print Kit Items: Disabling this option means that the individual items in a kit will not print on receipts 
but will still appear on the invoice screen. 
 
Print Account Balance: When this option is enabled, the account balance will print on receipts for “on 
account” customer. 
 
Number of Copies: This function allows you to specify how many copies of the receipt will print when 
you end a transaction. 
 
Print Full Size Info To:  This function allows you to choose an alternate location to which you can print full size 
invoices. 
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Station Specifics 
 
Print Extra Order Copy: When this option is enabled, an extra copy of the receipt will print to the 
specified location or the Order Filling Screen.  For example, a restaurant station dedicated to deliveries 
might want to print an entire receipt to the kitchen so it can be attached to deliveries. 
 
 
Couponing 
 
This function allows you to enter text to appear as a coupon on the bottom of each receipt.  In order to use 
this function, you must be using an Epson TMT-88 printer. 
 
 
Scale 
 

 
 
This button allows you to activate or deactivate the Hobart Weight Scale.  The scale creates a bar code to 
be scanned at checkout that indicates a calculated price based on weight.  To change the settings for this 
scale, click on the Scale button, then on the desired option, then on Done to save the new settings. 
 
Modifier Printers 

 
This function allows you to specify a networked port address (ex: //server/hp4000) for local LPT and 
COM ports on each Station ID.  This allows greater flexibility in printer placement and setup, especially 
in restaurant environments.  
 
In Inventory Maintenance, you may specify a location for a remote printer for an individual item to print 
to (See Chapter 2: Inventory Control).  This is used when you want to have the item printed to a remote 
printer (for restaurants).  When the printer is located on a network, it is given a network address. The 
computer that the remote printer is attached to locally needs to translate that network address to a local 
COM or LPT port. 
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Register 
 
Select this option to register your copy of Cash Register Express.  To access this option, select Register 
from the File menu (Modern) or Setup menu (Traditional).  The phone number and address for PC 
America will appear, followed by your activation number.  Call PC America with this activation number, 
and then enter the number they tell you. 
 
 
 
 

Enable Multiuser Edition 
 

This function allows multiple Station IDs in Cash Register Express.  To access this screen, select Enable 
Multiuser Edition from the Log-in Screen File menu.  To run Cash Register Express on a network, you 
must add a Station ID for each PC workstation (each cash register) that accesses the CRE system.  You 
must obtain a Network Support Password from PC America to add additional cash registers.   
 
 PC America: 1-800-PC-AMERICA 1-800-722-6374 
 
 Outside of US: 1-845-267-3500 
 
 Fax:  1-845-267-3550 
 
Once you have entered a valid password, you will be able to create additional Station IDs.  See Add 
Station in this chapter for more information on adding Station IDs. 
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The Invoice Screen 
 

Modern 
 

 
 

Traditional 
 

 
 
Cash Register Express 
works with or without 

a mouse.  You can 
access every aspect of 

Cash Register Express 
using an ordinary 

keyboard. 

After successfully entering your password, you will enter the Invoice 
Screen.  Everything you will need to do in CRE works from this one 
screen.  Every aspect of Cash Register Express works with or without a 
mouse.  You can move around the entire screen using either <TAB> or 
any of the numerous <ALT> shortcut keys.  You can bring up additional 
Cash Register Express screens using the <CTRL> shortcut keys. 
 
Any underlined letters on the screen are <ALT> shortcut keys.  For 
example, look at the word Invoice in the menu bar.  You can access 
Invoice either by clicking your mouse on the word Invoice or by 
pressing the <ALT-V> shortcut keys (press <ALT> and V 
simultaneously). 
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You can also use 
<TAB> to go from one 
section of the screen to 

another.  Press <SHIFT> and <TAB> simultaneously to go backwards.  
For details on the Invoice Screen, see Chapter 4: Creating Invoices.

Menu Bar 
 

Modern 
 

 
 

 
 

Traditional 
 

 
 
 
 

Access the Menu Bar by 
using the <ALT> keys or a 

mouse. 
 

For example: 
 

<ALT-V> = Invoice 
 

<ALT-H> = Help 
 

You may use lower or 
upper case letters. 

 
<ALT-T> = <ALT-t> 

You can access the Menu Bar by using a mouse or your <ALT> 
key.  You can access each menu listed on the menu bar by 
simultaneously pressing <ALT> and the underlined letter in the 
menu title.  To leave the menu bar, press <ESC> or press another 
<ALT> key to reach another part of the main screen.   
 
You can also press <ALT> to access the menu bar and then use the 
left and right arrow keys (<? > and <? >) to move from one menu 
to another.  Press <? > to display the highlighted menu. 
 
You may also use your mouse to click on the buttons (Modern) or 
picture icons (Traditional) that execute many of the functions in the 
drop down menus.  As you move your mouse across a picture icon 
in the Traditional Invoice Screen, its function will appear in the 
bottom left hand corner of the screen. 
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Options Menu 
 
The Options menu accesses many of the different functions available in Cash Register Express.  It is only 
viewable in the Modern Invoice Screen.  To access this menu, click on the Options button or press <ALT-
O> in the Modern Invoice Screen. 
 
Below you will find a brief description of each menu listed in the Options Menu.  More detailed 
descriptions will be found in future chapters. 

 
The Cashier Functions menu accesses functions used by cashiers while 
processing an invoice.  For more information on the functions listed in this 
menu, see Chapter 4: Creating Invoices: Cashier Functions. 
 
 
The Invoice Properties menu accesses functions to be applied to invoices, such 
as discounts and tax exempt status.  For more information on the functions 
listed in this menu, see Chapter 4: Creating Invoices: Invoice Properties. 
 
 
The Tools menu contains several tools to use with Cash Register Express.  For 
more information on the functions listed in this menu, see Chapter 6: Cash 
Register Express Tools: Tools Menu. 
 

 
The Setup menu allows you to change important information used by Cash 
Register Express.  For more information on the functions listed in this menu, 
see the next section, Chapter 1: Setting Up Cash Register Express: Setup 
Menu. 
 

 
The Administrative menu accesses functions used by administrators to manage 
Cash Register Express, such as inventory and customer maintenance.  For more 
information on inventory maintenance, see Chapter 2: Inventory Control.  
For more information on customer maintenance, see Chapter 3: Customer 
Control. 
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Setup Menu 
 

Modern 
 

 
 

Traditional 
 

 

 
The Setup menu allows you to change important information used by Cash Register Express.  To access 
the Setup menu in the Modern Invoice Screen, click on Options, and then click on Setup.  You can 
quickly select a menu or function by pressing the shortcut key shown in its upper left-hand corner.  Click 
on Done to exit the Setup menu.  To access the Setup menu from the Traditional Invoice Screen, click on 
Setup or press <ALT-U>. 
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Cashier Cash Drawer Location 
 
This feature allows you to change the location of the cash drawer for the current cashier.   
 
To change the location of the Cashier Cash Drawer: 
 

? ? Select Cashier CDL (Modern) or Change Cashier Cash Drawer Location (Traditional) 
from the Setup menu. 

 
? ? Type in the Administrator’s password, then click on OK or press <ENTER>. 

 
? ? Type in the number corresponding to the desired location of the cash drawer. 

 
 

Cost Markup Percentage 
 

 
This feature allows you to set the default price for an item as a certain percentage more than the cost of 
the item.  When adding the item to the inventory, the price will default to the cost markup percentage.  
The default price may be changed at any time.  To set a value for the Cost Markup Percentage, select Cost 
Markup (Modern) or Cost Markup Percentage (Traditional) from the Setup menu.  Type in the desired 
percentage then click on OK or press <ENTER>.  For example, if you want to set the cost markup 
percentage at 50%, you should type 50, not .5.  Click on Cancel to quit without selecting a percentage. 
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Customer Bonus 
 

 
The Customer Bonus screen allows you to define a bonus that a customer will receive once a specified 
number of bonus points have been accumulated.  The Activate Bonus field must be checked in order for 
CRE to award bonus points and determine if a customer has accumulated enough bonus points to qualify 
for the bonus described.  To access the Customer Bonus screen, select Customer Bonus from the Setup 
menu.  Use <TAB> or the mouse to move to the desired field, then type in the desired information.  Click 
on Update to save any changes made or click on Cancel to ignore any changes. 
 
NOTE: Bonus descriptions, cost, quantity, price, and taxable status may be overridden prior to adding the 
bonus item to the invoice.  Also, the customer may select not to take the bonus item at the time it is 
offered.   
 
Bonus ID: This is the default ID assigned by CRE.  It cannot be changed. 
 
# Bonus Points Required: This indicates the number of bonus points that a customer must accumulate to 
receive the bonus described.  Once the specified number of points has been accumulated, the bonus is 
added to the customer’s invoice - the cashier will be asked to accept (Add to Invoice) or reject the bonus 
(Cancel).  If accepted, the customer’s bonus points will be decreased accordingly. 
 
Activate Bonus: If this box is checked, bonus card information will be reviewed and applied by CRE for 
customers who are Bonus Plan Members. 
 
Tax: This indicates which tax is to be charged when the price of the bonus item is greater than 0. 
 
Bonus Description: This is the description that will appear on the invoice for the bonus item. 
 
Cost:  This is the actual cost of the bonus item.  Bonus items are tracked under a Non-Inventory number. 
 
Quantity:  This is the number of bonus items to be given. 
 
Price:  This is the price to be charged for the bonus item.  You can enter a price or 0 for no charge. 
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Discount Levels 
 

 
 

This feature allows you to set up discount levels for customers.  To choose a discount level for a customer, 
type the letter corresponding to the desired discount level - A, B, C, D, or E - in the Discount Level field 
of the Customer Maintenance Screen (See Chapter 3: Customer Control).  The default customer 
discount level is A.  The selected discount is automatically applied for each new inventory item added.  
You will be able to customize the discount levels on particular items (See Chapter 2: Inventory 
Control). 
 
NOTE: Inventory Level overrides will take precedence over customer discount levels. 
 
To change the value of a discount level: 
 

? ? Select Discount Levels from the Setup menu. 
 

? ? Use <TAB> or the mouse to move to the desired field. 
 

? ? Enter in the new discount percentage level. 
 

? ? Click on Update to save the new values or click on Cancel to ignore any changes. 
 
NOTE: Each discount level MUST have a value. 
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Display Setup 
 

 
 

The Display Setup screen allows you to change the appearance of the CRE Invoice Screen.  You can 
choose not to display the Toolbar or the Customer Display box.  To change your display setup, select 
Display Setup from the Setup menu.  X indicates that the option is displayed.  To disable an option, click 
on that box to remove the X. 
 
The Display Setup screen allows you to change which Invoice Screen will appear upon logging into CRE.  
To select the Modern Invoice Screen, click on the circle next to Modern, or click on the circle next to 
Traditional to select the Traditional Invoice Screen. 
 
You can also change the color of the background of the Invoice Screen by clicking on Set Form’s 
Background Color >> and then on the desired background color. 
 
When you are finished, click on Update.  You may click on Cancel to ignore all changes. 
 
 

General Invoice Notes 
 

 
 

This function allows you to add notes that will appear on the bottom of every receipt.  These notes could 
be a notice or a reminder about a sale date or a special offer.  You may enter up to ten lines of up to 42 
characters each.  To access this screen, click on General Invoice Notes in the Setup menu.  Use <TAB> 
or the mouse to move to each line.  Click on OK to save any changes in the text or click on Cancel. 
 
 

Setup Screen 
 

The Setup Screen allows you to customize Cash Register Express with your computer system setup.  To 
view the Setup Screen, select Setup Screen from the Setup menu.  For more information on each of the 
different settings, see Chapter 1: File Menu: Setup Screen. 
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Quick Books Setup 
 

 
 

The QuickBooks Setup allows you to identify the location of QuickBooks on your system and to specify 
account name information required to create a QuickBooks import file from your CRE Sales data.  To 
access this screen, select Quick Books Setup from the Setup menu. 
 
The import file posts totals to Undeposited Funds, Sales Income, and Sales Tax accounts.  A customer 
name and sales tax agency must also be identified.  The accounts and names must be defined in 
QuickBooks prior to importing files generated by CRE. 
 
QuickBooks Directory: This is the name of the directory in which QuickBooks is located. 
 
Customer Name: This is the customer name identified as responsible for sales income.  The default 
customer name is CRE customer (a single customer who represents all customers which made purchases 
via the CRE system). 
 
Undeposited Funds Account Name: If the name you select is a sub account of another account, place a 
colon “:” between the main and sub account.  In the example: 
 

Main Account - Undeposited Funds 
 
Sub Account - CRE Undeposited Funds 
 
Enter - Undeposited Funds:CRE Undeposited Funds 

 
Sales Income Account Name: If the name you select is a sub account of another account, place a colon 
“:” between the main and sub account.  In the example: 
 
 Main Account - Sales 
 
 Sub Account - CRE Sales Income 
 
 Enter - Sales:CRE Sales Income 
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Sales Tax Agency Name: This is the Sales Tax Agency associated with taxes passed to QuickBooks. 
 
Sales Tax Agency Account Name: If the name you select is a sub account of another account, place a 
colon “:” between the main and sub account.  In the example: 
  
 Main Account - Sales Tax Payable 
 
 Sub Account - CRE Sales Tax Payable 
 
 Enter - Sales Tax Payable:CRE Sales Tax Payable 
 
Control Buttons:   
 

Update - Click on this to exit and save all the changes in the QuickBooks Setup information. 
 
Cancel - Click on this to exit without saving any changes made in the QuickBooks Setup 
information. 

 
 

Set Tax Rate 

 
 

This screen allows you to change the tax rate and the descriptions of each tax rate.  The default tax rate is 
5% and the default description for each tax rate is Tax1, Tax2, and Tax3.  To access this screen, select 
Tax Rates (Modern) or Set Tax Rate (Traditional) from the Setup menu. 
 
To change the tax rate: 
 

? ? Select Set Tax Rate from the Setup menu. 
 

? ? Use <TAB> or the mouse to move to the desired field, then type in the new information.  
NOTE: Enter the rate as a percentage.  For example, enter 5.00% for five percent. 

 
? ? Click on OK to save the changes or click on Cancel to ignore any changes. 

 
NOTE:  Any changes in the descriptions of a tax rate are reflected on the printed receipts, and you must 
enter rates for all three tax levels.  Example: Canadian users may wish to label the first tax rate as GST 
and the second tax rate as PST, or liquor storeowners may want to designate the second tax as Liquor Tax. 
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Set Default Printer 
 

 
Use this function to specify the default printer.  You may change the default printer to send invoices and 
reports to a different printers based on your requirements.  To access this screen, select Set Default 
Printer from the Setup menu.   
 
The print setup in Cash Register Express is identical to the print setup in Windows.  Therefore, if you 
already set the printer in the Control Panel from Windows, you don’t need to set the printer here, and vice 
versa. 
 
TIP: If you are using a standard receipt printer (Star, Citizen, Epson, etc.), then select the driver 
“Generic / Text only” for receipt printouts. 
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 Bar Code Overview 
 

Cash Register Express works with any type of wedge barcode device.  
A wedge barcode device plugs into a “Y” type connector that allows the 
simultaneous use of a keyboard and barcode device using a single 
keyboard port. 
 
The best type of barcode device to use is a Laser type scanner that can 
read barcodes at a distance of up to 1 foot away without touching the 
barcode.  A Laser scanner costs about $500.  A CCD type barcode reader 
is a handheld device that must touch the barcode or be within ½ of an 
inch of it.  A CCD barcode scanner costs approximately $300.  The least 
desirable type of barcode scanner is a barcode wand that must actually 
be rubbed against the barcode to read it.  A barcode wand costs 
approximately $200.   
 
A barcode device is a simple instrument to use with Cash Register 
Express and it makes invoicing much easier.  For example, a 16-ounce 
bottle of Diet Coke has the barcode number 049660.  With Cash 
Register Express, you can either enter 049660 manually, or you can very 
quickly scan the number, just like in the supermarket. 
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Inventory Maintenance 
 

 
 
The Inventory Maintenance screen allows you to add items to your inventory as well as edit existing 
inventory items.  To access this screen from the Modern Invoice Screen, select Inventory Maintenance 
from the Tools menu or from the Administrative menu under Options.  To access this screen from the 
Traditional Invoice Screen, select Inventory Maintenance from the Inventory menu.  You can also press 
<F2> in either Invoice Screen. 
 
Once you have accessed the Inventory Maintenance screen, you can use <TAB> or the mouse to move 
from one field to another.  To add an item, click on Add or press <ALT-A>.  Enter the desired 
information, then click on Save or press <ALT-S> to save the new item.  To update a selected item, 
change the desired information then click on Update or press <ALT-U>.  To exit without making any 
changes, click on Exit or press <ALT-X>. 
 
NOTE:  Item Number and Description are required fields.  You MUST enter an item number and 
description for each item. 
 
General Info 
 
To access the General Info page, click on the General Info tab or press <ALT–G>. 
 
Department: This allows you to select a department for the inventory item.  Scroll through the 
Department list by using the cursor keys (<? >, <? >, <? >, <? >) or by clicking on the up and down 
arrows with your mouse.  Highlight the desired department, then press highlight the desired department.  
NOTE: The Department must first be added through Department Maintenance under Departments in 
the Inventory menu.  For more information on creating departments, see Chapter 2: Inventory Control: 
Department Maintenance. 
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Item Number: This is where you enter the unique identifier for an item.  It can be up to 18 characters 
long and consist of any combination of letters and numbers.  However, if you are using barcodes, as is 
recommended, you may only use numbers in the item number.  NOTE: Do not use any punctuation or 
spaces, except for the underscore (_), as part of the item number. 
 
Description: This is the description of the item that will appear on invoices and reports.  It can be up to 
30 characters long and consist of any upper and lower case letters, numbers, punctuation, or spaces.  
NOTE: Do not use the asterisk (*) as part of the item name. 
 
Cost: This is how much you paid for the item. 
 
Price: This is how much you are selling the item for. 
 
Retail Price: This is the manufacturer (or vendor’s) suggested retail price.  This field is for informational 
purposes only. 
 
In Stock: This displays the current number of this item that is in stock.  It is automatically updated after 
an invoice and can be changed manually at any time. 
 
Tax: This indicates which tax(es) should be charged to this item.  Click on the box next to the desired tax 
level(s) to choose the type of tax to be applied to this item. 
 
Preferred Vendor: This allows you to select a preferred vendor for an item.  Scroll through the vendor 
list by using the cursor keys (<? >, <? >, <? >, <? >) or by clicking on the up and down arrows with your 
mouse, then highlight the desired department.  This vendor will be the default vendor for purchase orders 
of this item.  NOTE: The vendor must first be added through Vendor Maintenance under Vendors in 
the Inventory menu.  For more information on adding vendors, see Chapter 2: Inventory Control: 
Vendor Maintenance. 
 
Reorder Level: This is the quantity at which you will be alerted to re-order the item.  It can be up to 5 
digits long. 
 
Reorder Quantity: This is the default quantity that will be placed on a purchase order for this item.  This 
quantity can be modified at any time. 
 
# of Barcodes: This allows you to mark the item for barcode printing through Bar Code Express.  Enter 
the number of bar codes that you want to print for this item here. 
 
Profit %: This displays the profit percentage for the displayed item. 
 
Retail Discount: This displays the retail discount percentage for the displayed item. 
 
Gross Margin: This is the percentage of the selling price that is profit. 
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Optional 
 
To access the Optional page, click on the Optional tab or press <ALT–O>. 
 

 
 
Days Valid: This is for how many days an item is valid.  It is usually used for tickets and vouchers and is 
for informational purposes only. 
 
Bonus Points: This specifies how many bonus points a bonus plan member will receive when purchasing 
this item. 
 
Modifier Item: A modifier item is an item that accents another inventory item.  For example, if you 
ordered a hamburger, ketchup would be considered a modifier item.  To mark an item as a Modifier Item, 
select Yes. 
 
Auto Weigh:  When this option is enabled for an item, CRE automatically takes the weight from the ECR 
Loc scale when the item is added to the invoice.  NOTE: You can enter a different tear values for 
different items. 
 
Serial Numbers: Select Yes if you want to have serial numbers for this inventory item.  At the time of 
sale, you will be prompted to enter a serial number.  The maximum is 20 characters and it may contain 
both letters and numbers. 
 
Part Number: Enter the preferred vendor’s item number for the item here.  This field is useful for 
purchase orders since they will show the vendor’s item number in addition to your own. 
 
Commission: This option allows you to determine how much commission is earned when this item is 
sold.  You can choose from % of gross, % of net, or a direct dollar amount.  To learn more about 
generating a report which lists all of the commissions earned by a salesperson, see Chapter 5: Reports: 
Reporting Screen: Employee Reports. 
 
Additional SKU’s: This option allows you to have more than one barcode associated with each item.  For 
example, for a Coke, you can have the usual barcode and also add a SKU “COKE”.  You can then invoice 
under either number.  To add a SKU for an item, click on Add then enter the alternate SKU.  To delete a 
SKU for an item, select the desired SKU then click on Del. 
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Special Pricing 
 
To access the Special Pricing page, click on the Special Pricing tab. 
 

 
 
Sale Pricing: This function allows you to place an item on sale for certain dates.  Enter the percent you 
want the item to be marked down in the % off field.  Enter the beginning date in the Starting field and 
the ending date in the Ending field.  NOTE: To place an item on sale for only one day, enter the same 
date in both date fields. 
 
Bulk Pricing: This function allows you to sell items in bulk for a price different than selling the same 
amount of items individually.  To set up a bulk price for an item, click on Add, enter the quantity needed 
to be purchased for bulk pricing, and then enter the new price.  To remove a bulk price for an item, select 
the desired sale price then click on Del. 
 
Time-Based Pricing: This function allows you to offer alternate prices on certain days within certain time 
ranges.  For example, a bar may offer a beer during happy hour on Fridays from 4PM to 6PM for a sale 
price of $2.00 while the normal price is $4.00.  To enter time-based price for an item, click on Add, select 
the day on which you want to offer the sale price, and then enter the start and end times.  To remove a 
time-based price for an item, select the desired price then click on Del. 
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Discounts 
 
To access the Discounts page, click on the Discounts tab or press <ALT–D>. 
 

 
 
Discount Levels: These are the discount percentages and the respective discount price for an item.  The 
discount prices are displayed once a price has been entered for an inventory item.  When the price is 
changed, the discount information is updated to reflect the change.  If the discounted price or percent is 
different than those from Setup discount levels, the inventory levels will take precedence.  If you enter a 
discount price, the percent will be updated.  If you enter a percent, the discount price will be updated.  
NOTE: The levels will default to the Setup discount levels, but these may be changed at any time. 
 
For an item to be discounted for one or more customer discount levels (A-E), the level must be enabled for 
the item.  To enable a discount level, click on the box under Enabled in that discount level’s row.  If a 
discount level is not enabled, customers with that level will be charged full price. 
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Matrix Info 
 
To access the Matrix Info page, click on the Matrix Info tab or press <ALT–M>.  This tab will only 
appear if no department has been selected or if the selected department is not a rental department. 
 

 
 
Group: This function allows you to select a group for the inventory item.  A group is a way to classify an 
item that has different styles.  For example, you may have a long skirt that comes in four colors (white, 
blue, black, and purple) and three sizes (Small, Medium, and Large).  In order to keep track of how many 
of each color and size you have, you need to use a group, such as Long Skirt.  Each size in each color can 
have its own item number, and you can keep track of how many ribbed shirts you have.  Scroll through the 
Group Name list by using the cursor keys (<? >, <? >, <? >, <? >) or by clicking on the up and down 
arrows with your mouse.  Once the desired group name is highlighted, select it by either pressing <TAB> 
or clicking on the next field with the mouse.  NOTE: The group name must first be added through Group 
Maintenance in the Administrative menu of the Setup Screen (Modern) or the Inventory menu 
(Traditional).  For more information on adding group names, see Chapter 2: Inventory Control: Group 
Maintenance. 
 
Size: This is the size of the item.  If you have an item that comes in different sizes (such as Small, 
Medium, and Large), you can use this field along with a group name to create a different item number for 
each size. 
 
Color: This is the color of the item.  If you have an item that comes in several colors (such as Black, 
White, and Blue), you can use this field along with a group name to create a different item number for 
each color. 
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Rental Info 
 
To access the Rental Info page, click on the Rental Info tab or press <ALT–R>.  This tab will only 
appear if the selected department is a rental department. 
 

 
 
# Days Rent: This is the number of days the item can be rented for without incurring any late charges.  
The maximum number of digits is two. 
 
Daily Late Charge: This is how much the customer will be charged per day once the item is overdue. 
 
Rating: This is the rating of the movie (Example: G, PG, PG-13, R, or NC-17). 
 
Item Approval Code:  This field is for informational purposes only.  You may enter an item approval 
code for a rental item in this field. 
 
Actor Name:  If the rental item is a movie, you may enter the leading actor’s name in this field. 
 
Actress Name: If the rental item is a movie, you may enter the leading actress’ name in this field. 
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Modifiers 
 
To access the Modifiers page, click on the Modifiers tab or press <ALT–M>. 
 

 
 
This function allows you to select which modifiers will be displayed when the item is added to an invoice. 
 
To select an item as a modifier for another inventory item: 
 

? ? Use <TAB> or the mouse to move the cursor to the Inventory List, then use <? > and <? > or the 
mouse to highlight the modifier item you wish to add to the Modifier List. 

 
? ? Once the item is highlighted, click on Add to add the item to the Modifier List.  Repeat this for 

every item you want to add as a modifier. 
 

? ? To remove an item from the Modifier List, use <TAB> or the mouse to move the cursor to the 
Modifier List, then use <? > and <? > or the mouse to highlight the modifier item you wish to 
remove.  Once the item is highlighted, click on Remove. 
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Printers 
 
To access the Printers page, click on the Printers tab or press <ALT–P>. 
 

 
 
This function allows you to select which printer(s) an item will print on and/or which monitor(s) an item 
will be displayed on.  For example, if a customer orders a Coke and a hamburger, you can print the soda 
order at the bar at COM1 and the hamburger at the grill at COM2. 
 
Add Monitor: Use this button to send an item to a monitor at a specified Station ID instead of (or in 
addition to) a printer.  The order can then be displayed on the selected station by choosing Order Filling 
from the File menu on the Restaurant Pro Express Login Screen. 
 
Add LPT Port: Use this button to select an LPT port for the item. 
 
Add COM Port: Use this button to select a COM port for the item. 
 
Add Port Address: Use this button to specify a networked port address (ex: //server/hp4000) for an item.  
This allows for much greater flexibility in printer placement and setup for restaurant environments. 
 
Add Windows Printer: Use this button to specify any printer that is set up in the Windows printer setup 
folder. 
 
Remove Port: Use this button to remove a networked port address from the list of printers. 
 
NOTE: You can choose to print to any printer that is setup on your system, including local and network 
printers.  Even if you don’t choose a printer, a receipt will print to the default printer if Print Invoices is 
set to YES in the Setup screen. 
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Sales History 
 
To access the Sales History page, click on the Sales History tab or press <ALT–H>. 
 

 
 
This screen displays all of the invoices on which the selected item was sold.  It displays the Invoice 
Number, Date, Time, Customer Number, Quantity, Cost, and Price. 
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Control Buttons 
 
Add: This will add the item to your inventory.  NOTE: Once an item has been added to your 
inventory, you cannot change the item number and it can only be deleted if it hasn’t been used in a 
previous invoice.  However, you can edit the item name. 
 
Update: This will save any changes made to the current item. 
 
Duplicate: If you have more than one of a particular rental item, you can use Duplicate to copy all of the 
information from one item number to a new item number.  This allows you to have the same information 
on more than one rental item without manually entering the information for each one. 
 
Instant PO: This allows you to generate an instant purchase order for the item. 
 
Reorder Report: This report displays a list of inventory items that have fallen below their respective 
reorder levels, separated by department.  The report contains the following information about each item: 
Item Number, Item Name, Department Number, Vendor Number, Vendor Name, Part Number, Cost, In 
Stock, Value, Price, Reorder Level, and Reorder Quantity. 
 
Delete: This will delete the current item from your inventory.  NOTE:  An item can only be deleted if it 
hasn’t been used in a previous invoice. 
 
Cancel:  Click on this button to cancel the current data entry. 
 
Exit:  Click on this button to exit the Inventory Maintenance Screen. 

 
Use the arrow buttons to scroll through your inventory item.  The Left arrow will display the previous 
item and the Right arrow will display the next item. 
 
To search for an item, type the item number or item name in the Search by Item Number or Search by 
Item Name field, or click on the down arrow to display a list of all the inventory items. You can also use 
the up and down arrows, <? > and <? >, to scroll through the inventory when that field is highlighted. 
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Department Maintenance 
 

 
 
A department is a way of grouping inventory items into different categories.  The Department 
Maintenance screen allows you to create or update departments. To access this screen, select Department 
Maintenance from the Administrative menu in the Options Menu (Modern) or from the Inventory 
menu (Traditional). 
 
To create a department: 
 

? ? Click on Add or press <ALT-A>. 
 
? ? Type in the new department ID in the Department ID field.  NOTE: Do not use an asterisk, *, 

in the Department ID. 
 

? ? Use <TAB> or the mouse to move the cursor to the Department Description field, then type in 
the description of the new department. 

 
? ? Click on the Department Type.  Select Rental to create a rental item department.  Select 

Employee to create an employee department.  Select Regular for all other types of departments. 
 

? ? Click on Save or press <ALT–S> to add the department.  Click on Cancel or press <ALT–C> to 
quit without creating a department. 

 
To update or delete a department: 
 

? ? Select the desired department.  Scroll through your departments by using the arrow buttons.  The 
Left arrow will display the previous department and the Right arrow will display the next 
department.  To search for a department, type the department ID in the Search by Dept ID 
field, or click on the down arrow to display a list of all the departments.  Once this field is 
highlighted, you can also use the up and down arrows <? > and <? > to scroll through the list. 

 
? ?Change the desired information, then click on Update or press <ALT-U>.  Click on Exit or 

press <ALT-X> to quit without saving any changes. 
 

? ? To delete the selected department, click on Delete or press <ALT-D>.  All of the items in the 
deleted department will show a blank department field. 

 
NOTE: To change the department ID for a department, select Change Department ID from the 
Department Maintenance Info menu.  You can also change the department sorting order by selecting 
Toggle Sort Order. 
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Kit Maintenance 

 
A kit is a group of inventory items that is sold as one item.  Each kit will have its own unique kit number, 
but it is considered a group of inventory items.  Kits are a faster method of adding individual items of a 
group to an invoice.  When a kit is added to an invoice, all of the inventory items associated with that kit 
number will be automatically placed on the invoice.  You may also specify a price for the kit that is 
different than the total of all the prices of the included inventory items.  
 
The Kit Maintenance screen allows you to add items to your inventory as well as edit existing inventory 
items.  To access this screen, select Kit Maintenance from the Administrative menu in the Options 
Menu (Modern) or from the Inventory menu (Traditional). 
 
Once you have accessed the Kit Maintenance screen, you can use <TAB> or the mouse to move from one 
field to another.  To add a kit, click on Add or press <ALT-A>.  Enter the desired information, then click 
on Save or press <ALT-V> to save the new item.  To update an item, change the desired information then 
click on Update or press <ALT-U>.  To exit without making any changes, click on Exit or press <ALT-
X>. 
 
NOTE:  Kit Number and Kit Name are required fields.  You MUST enter a kit number and kit 
name for each item. 
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Department Search Description: This allows you to select a department for the kit.  Scroll through the 
Department list by using the cursor keys (<? >, <? >, <? >, <? >) or by clicking on the up and down 
arrows with your mouse.  Highlight the desired department, then press highlight the desired department.  
NOTE: The Department must first be added through Add New Department under Departments in the 
Inventory menu.  For more information on creating departments, see Chapter 2: Inventory Control – 
Departments. 
 
Kit Number: This is the unique identifier for the kit.  It can be up to 18 characters long and consist of 
any combination of letters and numbers.  However, if you are using barcodes, as is recommended, you may 
only use numbers in the kit number.  NOTE: Do not use any symbols, punctuation, or spaces, except 
for the underscore (_), as part of the item number. 
 
Kit Name: This is the description of the kit that will appear on invoices and reports.  It can be up to 30 
characters long and consist of any upper and lower case letters, numbers, punctuation, or spaces.  NOTE: 
Do not use the asterisk (*) as part of the item name. 
 
Calc Cost Per: This is the calculated total cost of all the inventory items in the kit.  This is a read-only 
field.  You cannot enter information in this box. 
 
Calculated Price: This is the calculated price of the individual inventory items together in the kit.  This 
is a read-only field.  You cannot enter information in this box. 
 
Price Override: This is the price that will override the calculated price for the kit.  Even if the prices of 
the individual items change, the price override will remain the same.   
 
Tax: This indicates which tax(es) should be charged to this item.  Click on the box next to the desired tax 
level(s) to choose the type of tax to be applied to this item. 
 
Search by Item Name/Number: This is where you enter the item name or item number of the items that 
will be part of the kit.  You may scan or type in this information.   
 
Kit Grid: Once an item has been added to the kit, it will appear in the Kit Grid.  The grid displays the 
item number, item name, quantity, discount, price, and cost of the items included in the kit. You may 
change the quantity and specify a discount price for an item, but the Price Override will take precedence 
over the discounted calculated price.  
 
To create a kit: 
 

? ? Click on Add or press <ALT-A>. 
 

? ? Select the desired department, enter a kit number and kit name, and then enter the price override.  
You may use <TAB> or the mouse to move between fields.  NOTE:  You must enter a kit 
number and a kit description.  Department selection and Price Override are optional fields. 

 
? ? Add items to the kit grid by scanning or typing in the inventory items or select an item from the 

pull down menu.  Once the item is added, it will appear in the Kit Grid.  You may change the 
quantity or enter a discount price for each item in the grid at any time.  Repeat this for each item 
in the kit. 

 
? ? To delete an item from a kit, position the cursor on the desired item, and then press <CTRL–

DEL>. 
 

? ? Once you have finished entering all the items in the kit, click on Save or press <ALT–V> to add 
the kit to your inventory.  Click on Cancel or press <ALT–C> to quit without adding the kit. 
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Control Buttons 
 
Add: This button adds the kit to your inventory.  NOTE: Once a kit has been added to your inventory, 
you cannot change the kit number and it can only be deleted if it has never been sold.  However, you 
can edit the kit name. 
 
Delete: This will delete the current kit from your inventory.  NOTE:  A kit can only be deleted if it 
hasn’t been used in a previous invoice. 
 
Update: This will save any changes made to the current kit. 
 
Sales Summary: This will display a summary of sales per month of the current year for the kit.  The 
summary will display the total sales, cost, and quantity for each month. 
 
Next and Previous: These buttons allow you to scroll through your kits.  Next will display the next kit 
while Previous will display the preceding kit. 
 
Exit: Click on this button to exit without adding or updating a kit. 
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Group Maintenance 

 
A group is a way to classify an item that has different styles. Group Maintenance allows you to create 
groups for inventory items. 
 
To create a new group: 
 

? ? Select Group Maintenance from the Administrative menu in the Options Menu (Modern) or 
from the Inventory menu (Traditional). 

 
? ? Click on Add or press <ALT-A>.  Type in the new group name.  The group name can contain 

any alphanumeric characters.  Click on OK or press <ENTER> to create the group.  Click on 
Cancel to quit without creating a group. 

 
When you highlight a group in the Select Group list, all of the sizes and colors available for the group 
will be displayed in the grid.  Click on a cell in the grid to display information about that item.  The item 
number, description, and current quantity in stock will appear in the General Tab.  The On Order tab 
displays any open purchase orders for the selected item.  
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Group Maintenance also allows you to generate and receive purchase orders for group items. 
 
To generate a purchase order for an item: 
 

? ? Double-click on the desired item.  Enter the amount that you would like to place on order then 
click on OK or press <ENTER>. 

 

? ? Click on Generate PO or press <ALT-G>.  The item will appear on the Purchase Order grid 
with the entered quantity.  Modify any fields that may need to be changed, and then click on 
Create. 

 
To receive an item from an existing purchase order: 
 

? ? Click on the desired item to select it, then click on Receive from PO or press <ALT-R>. 
 

? ? Enter the quantity received, then click on OK or press <ENTER>.  Your inventory will be 
updated. 

 
To receive an item that does not have an existing purchase order: 
 

? ? Click on the desired item to select it, then click on Instant PO or press <ALT-P>. 
 

? ? Enter the amount received and select a vendor (if any), then click on Receive or press <ALT-R>.  
Click on Exit or press <ALT-X> to quit without receiving any items. 
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Express Input 
 

Express Input allows you to add or edit inventory items quickly because the screen is laid out in 
spreadsheet form.  To access this screen, select Express Input from the Administrative menu in the 
Options Menu (Modern) or from the Inventory menu (Traditional). 
 
Only certain fields are visible in Express Input: Department, Item Number, Item Name, Cost, Price, Retail 
Price, In Stock, Tax, Vendor, Reorder Level, Reorder Quantity, and # Bonus Points.  To edit any field of 
an item, use <TAB> or the mouse to move the cursor to the desired box, then type in the new information.  
To add an inventory item, use <TAB> or the mouse to move the cursor to the line marked with an asterisk 
‘*’ then type in the information.  Your inventory will be updated automatically when you enter or change 
data.  Click on Exit or press <ALT–X> to exit the Express Input screen. 
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Vendor Maintenance 
 
 

A vendor is a person or company from whom you purchase items in your inventory.  The Vendor 
Maintenance screen allows you to create or update vendors. To access this screen, select Vendor 
Maintenance from the Administrative menu in the Options Menu (Modern) or from the Inventory 
menu (Traditional). 
 
To create a vendor: 
 

? ? Click on Add or press <ALT-A>. 
 
? ? Type in a vendor number in the Vendor Number field.  You may wish to use a telephone 

number as a vendor number.  NOTE: Do not use an asterisk, *, in the vendor number. 
 

? ? Use <TAB> or the mouse to move the cursor to each field to enter the vendor’s information, then 
click on Save or press <ALT–S> to add the vendor.  Click on Cancel or press <ALT – C> to 
quit without creating a vendor. 

 
To update or delete a vendor: 
 

? ? Select the desired vendor.  Scroll through your vendors by using the arrow buttons.  The Left 
arrow will display the previous vendor and the Right arrow will display the next vendor.  To 
search for a vendor, type the vendor name or vendor number in the Search by Vendor # field, or 
click on the down arrow to display a list of all the vendors.  Once this field is highlighted, you 
can also use the up and down arrows <? > and <? > to scroll through the list. 

 
? ? Change the desired information, then click on Update or press <ALT-U>.  Click on Exit or 

press <ALT-X> to quit without saving any changes. 
 

? ? To delete the selected vendor, click on Delete or press <ALT-D>.  NOTE:  Only vendors that 
are not preferred vendors for an item may be deleted. 



Chapter 2: Inventory Control 

Cash Register Express 58 

Purchase Orders 
 

 
 

The Purchase Orders screen allows you to create and update purchase orders.  To access this screen, select 
Purchase Orders from the Administrative menu in the Options Menu (Modern) or from the Inventory 
menu (Traditional). 
 
The main screen displays all open purchase orders: 
 
PO #: This is the purchase order number.  It is assigned by CRE after the purchase order is created and 
cannot be modified. 
 
Date: This is automatically set to the current date.  It cannot be modified. 
 
Ref #: This is an optional field and is assigned by the user. 
 
Vendor #: You must enter a vendor number for each purchase order.  This is the vendor from whom you 
are purchasing the order. 
 
Due Date: You must enter a due date for each purchase order.  This is the date by which the order should 
be received. 
 
Status: This is the current status of the purchase order: O-open purchase orders, C-closed purchase 
orders, or V-voided purchase orders. 
 
Total Cost: This is the total cost of the order.  It is automatically calculated by CRE and cannot be 
modified. 
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To create a purchase order: 
 

? ? Click on Add or press <ALT-A>, then enter the desired information: 
 

? ? Once all of the information has been entered, click on Save or press <ALT-S> to save the 
purchase order.  Click on Cancel or press <ALT-C> to quit without saving the new purchase 
order.  You will be asked if you would like to print a copy of the purchase order after saving it. 

 
To update a purchase order: 
 

? ? Double-click on the desired purchase then make any necessary changes. 
 

? ? Click on Update or press <ALT-S> to save your changes.  Click on Cancel or press <ALT-C> 
to quit without making any changes. 

 
To close a purchase order: 
 

? ? Double-click on the desired purchase order. 
 

? ? Click on Close or press <ALT-L> to close the current purchase order.  Click on Cancel or press 
<ALT-C> to quit without closing the purchase order.  NOTE: Closed purchase cannot be 
reopened. 

 
 
General Information 
 

 
Select Vendor: You must select a vendor for each purchase order.  This is the vendor from whom you are 
purchasing the order.  Use the mouse to click on the desired vendor. 
 
Instructions: You may enter instructions for the purchase order in this field. 
 
Ship Via: This is an optional field and is assigned by the user.  It is the method by which the order is 
being shipped (Example: UPS Ground, Fed Ex Overnight, etc.). 
 
Reference #: This is an optional field and is assigned by the user. 
 
Terms: This is an optional field.  It is automatically entered if there are terms present for the vendor.  The 
user can override this information.  (Example: Net 30) 
 
Due Date: You must enter a due date for each purchase order.  This is the date by which the order should 
be received. 
 
Ship To: This is an optional field and the user may modify it.  The default Ship To Address is the address 
located in the Company Information screen.  You may add additional lines for Attn:, phone number, etc. 
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Add Items 
 

 
 
Select Vendor: You can select a vendor by typing the entire vendor name then pressing <ENTER>. You 
can also type the first few characters of the vendor then use the mouse to click on the down arrow to 
display a list of vendors beginning with those characters.  Use the up and down arrows, <? > and <? >, to 
scroll through the vendors when that field is highlighted. 
 
At Reorder Point: To display only items that have reached their reorder points, click on this box.  Leave 
this box empty to display all items even if they have not reached their reorder points. 
 
With Open POs: To display only items that have open purchase orders, click on this box.  Leave this box 
empty to display all inventory items. 
 
Find Item: Click on this button to find an item by item number. 
 
Inventory Selection Grid: This displays the items that can be added to a purchase order.  Double-click on 
an item to add it to the purchase order.  The grid displays the Item Number, Item Name, quantity in stock, 
reorder level, reorder quantity, reorder cost per item, Vendor Number, Part Number, and Department ID 
for each item. 
 
Added Inventory Grid:  This grid displays the items that have been added to the purchase order.  The 
grid displays the Line Number, Item Number, Description, reorder quantity, reorder cost per item, total 
cost, and number received.  Once an inventory item is selected and added to a purchase order, the quantity 
and cost may be modified.  To delete an item from the purchase order, press <CTRL–DEL> while the 
cursor is positioned on the item. 
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To receive items on a purchase order: 
 

? ? Double-click on the desired purchase order. 
 

? ? To receive one item on the purchase order, click on Receive Item or press <ALT-I>.  To receive 
all of the items on the purchase order, click on Receive All or press <ALT-A>. 

 
? ? If you choose to receive a single item, you will be prompted to enter the line number of the item 

to receive.  Enter the desired line number then click on OK or press <ENTER>. 

 
? ? Next you will be prompted to enter the quantity received of that item.  Enter the received amount 

then click on OK or press <ENTER>. 

 
? ? Click on Update or press <ALT-U> to update the purchase order and the inventory. 

 
 
To print a purchase order: 
 

? ? Double-click on the desired purchase order. 
 

? ? Click on Print or press <ALT-P>. 
 
Control Buttons 
 
Add: This creates a new purchase order. 
 
Update: This updates any changes made to the displayed purchase order. 
 
Close: This closes the displayed purchase order.  NOTE: Closed purchase orders cannot be reopened. 
 
Cancel: This exits the edit mode without saving any changes made. 
 
Exit: Click on this to exit the Purchase Orders screen. 
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Instant PO’s 

 
This feature allows you to generate an instant purchase order for an item.  You can use this function to 
add additional stock at a new cost and CRE will automatically calculate the average cost of this item if 
Average Cost Method is enabled in the Setup Screen.  To generate an instant purchase order, select 
Instant PO’s from the Inventory menu (Traditional only).  Enter the purchase order information then 
click on Receive or press <ALT-R> to receive the purchase order.  Your inventory will automatically be 
updated.  Click on Clear or press <ALT-C> to clear the entered information.  To quit without receiving 
the purchase order, click on Exit or press <ALT-X>. 
 
Enter Item #: Enter the item number of the item being received here. 
 
Quantity Received: Enter the received quantity of the item here. 
 
Cost Per: Enter the cost per item in this field. 
 
Vendor: You may select a vendor for the purchase order here.  Select None if there is no preferred vendor 
for this item. 
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Back Orders 

 
This screen displays either the items that are currently on backorder for a selected customer or the 
customers for whom a particular item is on backorder.  The grid displays the date the backorder was 
placed, customer number, item number, item name, the quantity placed on backorder by the customer, the 
current quantity in stock, amount paid, whether or not the backorder was prepaid, and the invoice number.  
To access this screen, select Back Orders from the Administrative menu in the Options Menu (Modern) 
or select Display Backorders from the Inventory menu (Traditional). 
 
To view items on backorder for a customer: 
 

? ? Type the desired customer number in the For Customer # field. 
 

? ? Press <TAB> to move the cursor to a new field.  Only backorders for the entered customer will 
be displayed. 

 
To view which customers have placed a certain item on back order: 
 

? ? Type the desired item number in the For Item # field. 
 
? ? Press <TAB> to move the cursor to a new field.  Only backorders for the entered item will be 

displayed. 
 
There are three options for displaying backorders.  Select All Open Backorders to display all backorders 
that have not yet been filled.  Select Backorders Covered by Stock to only display backorders for items 
that are currently in stock.  Select Backorders Not Covered by Stock to only display backorders for 
items that are not in stock. 
 
To fill a backorder, either double click on the desired backorder or highlight the desired backorder then 
click on Fill Backorder or press <ALT-F>.  The item will be added to the current invoice.  Click on Exit 
or press <ALT-X> to exit without filling a backorder. 
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Inventory Sort Order 
 

You can choose to sort your inventory items and kits by either item name or by item number.  To change 
the way you sort your inventory in the Modern Invoice Screen, select Toggle Item Search from the Tools 
menu or press <SHIFT-F2>. 
 
In the Traditional Invoice Screen, sort your inventory by item name by clicking on Inventory/Kit Sort 
Order in the Inventory menu then select Sort by Item Name, or press <SHIFT–F7> in the Invoice 
Screen.  To sort your inventory by item number, click on Inventory/Sort Order in the Inventory menu 
then select Sort by Item Number, or press <SHIFT–F8> in the Invoice Screen.  A check will appear 
next to the current manner of sorting inventory. 
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Customer Maintenance 
 
Every transaction in Cash Register Express uses a specific customer, and each customer must have a 
customer number.  The default customer is Customer #101 (Cash Customer).  Businesses who are 
running a cash business, such as a convenience store, that don’t need to store customer names or 
addresses should use Customer #101.  However, stores such as video stores or restaurants may want to 
keep their customers’ names, addresses, and telephone numbers on file.  These stores should use 
Customer Maintenance to add and edit customers. 
 
NOTE: The Cash Customer is a necessary customer to have. Do not edit this customer.  If this customer 
gets edited or in any way deleted, you must replace it by running the Check Database utility in the File 
menu of the Login Screen (See Chapter 1: Setting Up Cash Register Express). 
 

 
 

Customer Maintenance allows you to create and update customer numbers for a customer.  To access this 
screen from the Modern Invoice Screen, select Customer Maintenance from the Tools menu or from the 
Administrative menu under Options.  To access this screen from the Traditional Invoice Screen, select 
Customer Maintenance from the Inventory menu.  You can also press <F4> in either Invoice Screen. 
 
Once you have accessed the Customer Maintenance screen, you can use <TAB> or the mouse to move 
from one field to another.  To add a customer, click on Add or press <ALT-A>.  Enter the desired 
information, then click on Save or press <ALT-V> to save the new customer.  To update a selected 
customer, change the desired information then click on Update or press <ALT-U>.  To exit without 
making any changes, click on Exit or press <ALT-X>. 
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General Info 
 
The General Info screen is displays all the general information about a customer, such as name, address, 
and phone number.  To access this screen, click on the General Info tab or press <ALT–G>. 
 

Customer Number: This is the unique identifier for a customer.  Every customer MUST have a customer 
number.  Customer #101 is the default cash customer and cannot be changed.  Customer numbers can be 
up to 10 digits long and can contain any alphanumeric characters.  Some common customer numbers are 
phone numbers or a zip code followed by the first three letters of the customer’s last name.  NOTE: Do 
not use any punctuation or spaces, except for the underscore (_), as part of the customer number. 
 

Discount Level: This is the selected discount level for the customer.  Click on the arrow to drop down the 
box for more choices.  The default discount level is “A”.  The discount levels correspond to the levels 
specified under the Setup menu.  Each time an inventory item is selected for a customer invoice, the price 
will be based upon the customer’s discount level.  NOTE: You can override Setup discount levels for an 
inventory item. 
 

Tax Exempt (Y/N): This indicates whether or not the customer is tax exempt.  If a customer is tax 
exempt, click on the box to put a check in it.  If the customer is not tax exempt, leave the box empty. 
 
 
Account Info 
 

 
 
The Account Info screen displays all the information about a customer’s account. To access this screen, 
click on the Account Info tab or press <ALT–C>. 
 
Open Account Date: This is the date that the customer’s account opened.  A customer with an open 
account may pay for invoices On Account.  To open an account for a customer, click on the O to the right 
of the Open Account Date field.  The current date will appear in the Open Account Date field.  You may 
also manually enter an open account date if it is different than the current date. 
 
Close Account Date: This is the date that On Invoice payment for the customer was terminated.  To close 
a customer’s account, click on the C to the right of the Close Account Date field.  The current date will 
appear in the Close Account Date box.  You may also manually enter a close account date if it is different 
than the current date. 
 
Authorized Members:  Enter all members that are authorized to charge on account under this customer. 
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Default Salesperson: If CRE is set to prompt for the salesperson ID, the default salesperson ID entered 
here will be the default for the prompt box for this customer. 
 
Membership Expiration Date: This is the date when the customer’s club membership expires.  This date 
bears no relation to On Account info or the Bonus Points Plan. 
 
Bonus Points Achieved: This is the current number of bonus points that the customer has accumulated 
for the bonus plan. 
 
Max Balance: This is the maximum amount a customer may charge to their account.  If Max Balance is 
enabled in the Setup Screen, customers will not be allowed to charge any amount on their account greater 
then their max balance. 
 
Member Bonus Plan: If a Customer Bonus Plan is activated, this indicates whether the customer is a 
member. Click on the box to enroll the customer in the plan.  Leave the box empty if the customer is not a 
bonus plan member. 
 
Customer Balance: This is the current on account balance for the customer. 
 
Detailed Account Info: Click on this button to display the Accounts Receivable screen.  NOTE:  You can 
also access the Accounts Receivable Screen by selection Accounts Receivable from the Info menu on 
the Customer Maintenance screen.  For more information on this screen, see Customer Maintenance – 
Accounts Receivable. 
 
Card Swipe IDs: This function can only be used with magnetic-swipe membership cards.  The swipe ID 
serves as an alternate lookup for these customers. 
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Extended Info 
 

 
 
The Extended Info screen displays information about the credit card most often used by the customer.  
CRE automatically inserts this information into the CRE Credit Card Processing screen for manual 
processing or processing via IC VERIFY. To access this screen, click on the Extended Info tab or press 
<ALT–I>. 
 
Credit Card Type: Choose the type of credit card most often used by the customer.  You can choose from 
MasterCard, Visa, American Express, and Discover.  If the customer does not have a credit card, choose 
None.   
 
Credit Card Number: Enter the credit card number without any spaces. 
 
Credit Card Expiration: Enter the expiration date of the credit card in the format MMYY. 
 
Referral Source: This field allows you to record where the customer heard about your company.  To 
choose a referral source, click on the arrow and select the desired source.  NOTE: Referral sources must 
first be entered in the Account Control tab of the Setup Screen. 
 
Event Date:  You may enter an event date for a customer, such as a birthday or anniversary, in this field.  
You can then print labels for a specified range of event dates.  See Print Customer Labels for more 
information. 
 
Event Description:  This is the description for the event date entered in the previous field.  You can then 
print labels for a specified event description.  See Print Customer Labels for more information. 
 
E-mail Address:  Enter the customer’s e-mail address in this field. 
 
Mobile Phone: Enter the customer’s mobile phone number in this field. 
 
Fax: Enter the customer’s fax number in this field. 
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Ship To Info 
 

 
 
The Ship To Info screen allows you to create a Ship To address for the current customer.  Customers can 
choose to have their items from an invoice sent to their Ship To address.  To access this screen, click on 
the Ship To Info tab or press <ALT–S>. 
 
NOTE: To add the Ship To address to an invoice being processed, click on More Info in the Invoice 
Screen, and then check the Send To Ship To Address box. 
 
 
Notes 
 
The Notes screen displays notes about the customer.  To access this screen, click on the Notes tab or press 
<ALT-O>. 
 
 
Control Buttons 
 
Next and Previous: These buttons allow you to scroll through your customers.  Next will display the next 
customer while Previous will display the preceding customer. 
 
Add: This creates a new customer number. 
 
Update: This updates any changes made to the customer information. 
 
Delete: This will delete the displayed customer number from your database. 
 
Exit: Click on this button to exit from the Customer Maintenance screen.  All unsaved information will 
be lost. 
 
Search by Customer #/Last Name:  To search for a customer, type the customer number or last name in 
the Search by Customer # or Search by Last Name field, or click on the down arrow to display a list of 
all customers. You can also use the up and down arrows, <? > and <? >, to scroll through customers when 
that field is highlighted. 
 
Select for Current Invoice: Click on this box to select the current customer for the current invoice. 
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Accounts Receivable 
 
The Accounts Receivable screen allows you to update and manage a customer’s account.  To access this 
screen, select Accounts Receivable from the Info menu or press <CTRL-A> in the Customer 
Maintenance screen. 
 
Invoices 
 

 
 
The Invoices tab allows you to make payments on a customer’s account.  To access this screen, click on 
the Invoices tab. 
 
To make a payment on an account: 
 

? ? Select the desired customer in the Customer Maintenance screen, and then select Accounts 
Receivable from the Info menu. 

 
? ? Select the transaction type (Standard Payment) by clicking on the arrow next to the Transaction 

Type field and highlighting the desired method. 
 
? ? Select which invoice to which you would like to apply the payment.  You may choose Oldest to 

apply the payment to the oldest invoice, or you can choose a specific invoice number.  Select an 
invoice number by clicking on the arrow next to the Select Inv # field and highlighting the 
desired invoice number. 

 
? ? Choose the payment method (Cash, Check or Credit) by clicking on the arrow next to the Pay 

By field and highlighting the desired method. 
 

? ? Enter the amount for the transaction in the Amount field. 
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? ? If you make a mistake, you can click on Clear or press <ALT–L> to clear any information that 
has been entered.  You can also click on Exit or press <ALT–X> to exit the Accounts 
Receivable screen. 

 
? ? Click on Apply Payment or press <ALT–A> to apply the payment.  If the form of payment is by 

check, you will be prompted to enter the check number.  If the form of payment is credit card and 
no credit card information is entered in the Customer Maintenance screen, you will be 
prompted to enter the credit card number and expiration date. 

 
NOTE: If Prompt Cashier ID is set to Yes in the Setup Screen, you will be prompted to enter your 
Cashier ID when entering a payment. 
 
 
To print a statement: 
 

? ? Click on Statement or press <ALT-S> from the Invoices. 
 
? ? Enter the starting and ending date for the transactions for which you want to print a statement. 

 
NOTE: Statements are formatted so that the address appears in the window of standard mailing 
envelopes. 
 
 
Payments 
 

 
 
The Payments screen allows you to view all the transactions made on the customer’s account. To access 
this screen, click on the Payments tab. 
 
Date: This column shows the date that the transaction was completed. 
 
Amount: This column shows the amount for the payment. 
 
Bal After: This column shows the balance after the payment was applied. 
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Change Customer Number 

 
This function allows you to change the customer number for any given customer.  To use this function, 
select Change Customer # from the Info menu in the Customer Maintenance screen.  Enter the new 
customer number, then click on OK or press <ENTER>.  Click on Cancel to exit without changing the 
customer number.  NOTE:  You cannot change the customer number for Cash Customer. 
 
 
Print Customer Labels 

 
Print Customer Labels allows you to print labels for a customer on a Barcode Blaster label printer.  You 
can choose to print a label for the current customer, all customers, customers who satisfy a specified bonus 
point range, or customers who satisfy a specified event description and date range.  Each label has the 
customer number as a barcode and displays the customer name, address, city, state, and zip code.  To 
access this menu, click on Print Customer Labels in the Customer Maintenance menu bar or press 
<ALT–L> while in the Customer Maintenance screen.  To print a label for the current customer, select 
Current Customer or press <CTRL–L>.  To print a label for all customers, select All Customers or 
press <CTRL–A>.  To print a label for all customers who satisfy a specified bonus range, select Bonus 
Point Range or press <CTRL–B>.  You will be prompted to enter the lower and upper limits for the 
bonus point range.  To print a label for all customers who satisfy a specified event date and description, 
select Event Range or press <CTRL-E>.  You will be prompted to enter an event description and the 
upper and lower limits for the event date range.  To include all event descriptions in your range, enter ‘*’ 
for the event description. 
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Chapter 4: 
 
 
Creating Invoices 
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The Invoice Screen 
 

Modern 
 

 
 

Traditional 
 

 
 
The Invoice Screen is where all of your daily invoicing will be done.  Administration tasks such as 
Reports, Accounts Receivable, Purchase Orders, and Inventory Control are performed in different 
screens in Cash Register Express and are explained in other chapters. 
 
Before you begin processing invoices, you must manually enter your inventory items into CRE. You may 
want to enter just a few items at first so you can get a feel of how the program works, and then 
progressively add more items.  Refer to Chapter 2: Inventory Control for more information on adding 
inventory items. 
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Cashier Functions 
 

 
 

The Cashier Functions screen displays functions used by cashiers.  To access the Cashier Functions menu 
in the Modern Invoice Screen, click on Options, and then click on Cashier Functions, or simply press 
<F10> in the invoice screen.  You can quickly select a menu or function by pressing the shortcut key 
shown in its upper left-hand corner.  Click on Done to exit the Setup menu.   
 
 

Change Cashier ID 
 
 

This screen allows you to change the ID of the current cashier without exiting the program and logging in 
again.  Invoices are tracked by Cashier ID, and any settings saved for the Cashier ID will be automatically 
recalled.  The administrator may enter the administrator password to override any functions that are 
locked out to the cashier. 
 
To change the current Cashier ID: 
 

? ? Select Change Cashier ID from the Cashier Functions screen (Modern) or select Change 
Cashier ID from the Setup menu (Traditional). 

 
? ? Type in the new Cashier ID, then click on OK or press <ENTER>.  

 
? ? Enter the password for the specified Cashier ID. 
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Open Drawer 
 
This function lets you open the cash drawer with the administrator password.  You can also use this 
function to verify that your cash drawer is functioning properly.  To open the cash drawer, select Open 
Drawer from the Cashier Functions screen (Modern) or select Open Cash Drawer from the Setup 
menu (Traditional).  Type in the administrator password, then click on OK or press <ENTER>. 
 
 

Clock In/Clock Out 
 

 
 
This function allows employees to clock in or clock out.  Restaurant employees are prompted to enter the 
amount of tips they collected when they clock out.  To access this screen, select Clock In/Clock Out from 
the Cashier Functions screen (Modern) or select Clock In/Clock Out from the Tools menu.  To clock in, 
click on Clock In or press <ALT-I>.  To clock out, click on Clock Out or press <ALT-O>.  Click on 
Cancel or press <ALT-C> to quit without clocking in or out. 
 
 

Recall Invoice 
 
This function allows you to display a completed or voided invoice.  To view an invoice, select Recall 
Invoice from the Cashier Functions screen (Modern) or select Recall Invoice from the Sales 
Information menu.  To reprint the invoice from this screen, click on Print Invoice or press <ALT–P>.  
Once you are done viewing an invoice, click on End Display or press <ALT–E> (Modern) or Done or 
<ALT-D> (Traditional) to exit this screen. 
 
NOTE: When you recall an invoice, you cannot edit it in any way, nor can you delete it. 
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Recall On Hold Invoice 
 

This function allows you to recall an on hold invoice by the Hold ID that you entered when you originally 
put it on hold.  Once you recall an on hold invoice, you can process it to completion, void it, modify it, or 
put in on hold again.  To access this screen, select Recall On-Hold Invoice from the Cashier Functions 
screen (Modern) or select Recall On Hold Invoice from the Sales Information menu.  For more 
information on placing an invoice on hold, see Chapter 4: Creating Invoices: Dissecting the Invoice 
Screen. 
 
 

Display On Hold ID Numbers 
 

This function displays an on screen report of all the invoices currently on hold.  The report also shows the 
corresponding On Hold ID, invoice number, as well as the date and time that the invoice was placed on 
hold.  You can use this report if you forget the On Hold ID for an invoice.  To access this screen, select 
Display on Hold Ids from the Cashier Functions screen (Modern) or select Display On Hold ID 
Numbers from the Sales Information menu (Traditional). 
 
 

Look Up Customer 
 

This function allows you to display and select from a list of all invoices processed for a particular 
customer.  To access this screen, select Look Up Customer from the Cashier Functions screen (Modern) 
or select Look Up Customer in the Sales Information menu or press <CTRL–U> (Traditional).  Once 
you enter the customer maintenance screen, locate the correct customer by either entering the customer 
number or last name or by using Next and Previous.  Once the desired customer is displayed, click on 
Select or press <ALT–L> to view the Invoice Screen.  Click on the down arrow in the Select Invoice to 
View field to view a list of invoices for the selected customer.  The invoices are marked as ‘O’ (on hold), 
‘V’ (void), or ‘C’ (completed).  Use the mouse to click on the invoice you wish to view or use the arrow 
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Price Check 
 

 
 

This function allows you to view the description, price, tax, and total of a particular item without adding it 
to the invoice. 
 
To do a price check: 
 

? ? Select Price Check from the Cashier Functions screen (Modern) or select Price Check in 
the Inventory menu (Traditional).  You can also press <F5> in either screen. 

 
? ? Scan or type in the item number, then press <ENTER> to display the item information. 
 
? ? Click on Exit or press <ENTER> or <ALT–X> to exit. 
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Return Rentals 
 

 
 

Cash Register Express allows for items to be rented if they are in a Rental Type Department.  When a 
customer returns an item that has been rented, select Return Rentals from the Cashier Functions screen 
(Modern) or select Return Rentals from the Inventory menu or press <CTRL-F1> (Traditional) to 
return the item to the store.   
 
To return a rented item: 
 

? ? Select Return Rentals from the Cashier Functions screen (Modern) or select Return 
Rentals from the Inventory menu or press <CTRL–F1> (Traditional). 

 
? ? Type in the item number of the item being returned, then press <ENTER>. 
 
? ? CRE will display the Department, Item Number, Item Name, and Status of the returned item 

that was just entered. 
 

? ? Click on Exit or press <ALT–X> to exit. 
 
 

Hold and Print 
 
This function prints the invoice and puts it on hold.  You will be prompted to enter an On Hold ID of up 
to 4 characters.  To use this function, select Hold and Print from the Cashier Functions screen (Modern) 
or select Print On Hold Invoice from the Invoice menu (Traditional). 
 
 

Print Last Receipt 
 
This function allows you to print a receipt for the last invoice that was processed.  If an item is added to 
the current invoice, the function changes to Print Receipt and you can print a receipt for the current 
invoice.  To access this function, select Print Receipt from the Cashier Functions screen. 
 
 

Print Docket 
 
This function allows you to print a receipt without prices.  To access this function, select Print Docket 
from the Cashier Functions screen. 
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Dissecting the Invoice Screen 
 

Modern Invoice Screen 
 
Item Search 
 

 
 
Item Search is the section of the Invoice Screen where you ring up the items that the customer wants to 
purchase.  You can search for inventory items by item number or by item name.  You can set this 
parameter by selecting Toggle Item Search from the Tools menu. 
 
To add an item to the current invoice using the bar code scanner, scan the bar code of an inventory item 
when the cursor is blinking in the Search by Item Number box.  The number will appear on the grid.  If 
you are entering the number by hand, you must press <ENTER> after typing the number.  You can also 
partially enter an item number and then press the down arrow key <? > to get a listing of all items 
beginning with those numbers.  For example, if you know that the item number of a can of Coke begins 
with 0112 but don’t know the rest, you can type 0112 then press <? > and all the items whose numbers 
begin with 0112 will be displayed. 
 
If the quantity for an item you are adding to the invoice is different than one, you may change it prior to 
scanning or entering the item by pressing <ALT-Q> or clicking on the Quantity box.  Note that the 
quantity can be negative and it does not need to be a whole number.  If the customer is returning an 
item, use a negative quantity.  This will add a negative amount to the current total as well as 
properly update the in-stock amount of the inventory item once the transaction is completed. 
 
Once all of the items have been added and you have selected the payment method (cash is the default), 
press <ALT-E> or click on End Transaction to complete the invoice. 
 
 
Totals 
 

 
 

Running totals are kept for the current invoice.  Each time you add a new inventory item to the invoice, 
the totals portion is updated.  If you are using a pole display, it will be updated as well. 
 
Sub Total: This line displays the total amount of all the items in the invoice added together before taxes 
or discounts. 
 
Tax: This line displays the total amount of tax for the invoice before any invoice discounts. 
 
Grand Total: This line displays the invoice total after taxes but before any invoice discounts. 
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Invoice Grid 
 

 
 

The Invoice Grid shows all of the items that are in the current invoice.  Four columns are always in view: 
Line #, Item # and Description, Quantity, and Price.  Scrolling to the right by clicking on the right 
arrow in the bottom right-hand corner of the grid reveals additional information about the item.   NOTE: 
A cashier can only scroll to reveal additional information about an item if both Add Inventory/Kits and 
Update Inventory/Kits are set to “Yes” in the Permissions tab of the Employee Maintenance screen. 
 
 
Item Options 
 

 
 
Use the Item Options to change information on an invoice.  Select Item Options from the Invoice menu 
or press <F12> to display these buttons 
 
Delete: Click on a line on the Invoice Grid then click on Delete or press <CTRL-DEL> to delete an item 
from the invoice. 
 
Discount: This function allows you to apply a discount to a specific line of the current invoice.  Click on a 
line on the Invoice Grid then click on Discount or press <CTRL-L> to apply the discount.  You will be 
prompted to enter the percentage off. 
 
Up/Down: Use these buttons to move the highlighted cursor in the Invoice Grid.  Click on Up or press 
<ALT-U> to move the cursor up to the previous item.  Click on Down or press <ALT-D> to move the 
cursor down to the next item. 
 
Quantity Change: To change the quantity of an item once it has been added to the invoice grid, click on 
the desired item, then click on Quan Change or press <ALT-U>.  You will be prompted to enter the new 
quantity. 
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Price Change: To change the price of an item once it has been added to the invoice grid, click on the 
desired item, then click on Price Change or press <ALT-P>.  You will be prompted to enter the new 
price. 
 
Invoice Options 
 

 
 
Use Invoice Options to end, void, or hold an invoice, modify the payment options display, or change the 
properties of the entire invoice. 
 
End Transaction: Once all of the items have been added to the invoice, click on End Transaction or 
press <ALT-E> to complete the invoice. 
 
Void Invoice: To void the current invoice, click on Void Invoice or press <CTRL-V>. 
 
Hold Invoice: This function allows you to place the current invoice on hold.  Hold Invoice could be used 
if the cashier began ringing up an order but then the customer realized that he forgot to pick up something 
on his list.  The cashier could place the invoice on hold and ring up other customers in line while the 
original customer gets the forgotten item.  To place an invoice on hold, click on Hold Invoice or press 
<CTRL-H>.  You will be prompted to enter an On Hold ID of up to 4 characters to use later to recall the 
invoice. 
 

NOTE: To recall an on hold invoice, select Recall Invoice from the Cashier Functions menu in the 
Options menu.  You will be prompted to enter the Hold ID that you originally entered when you placed 
the invoice on hold. 
 
Payment Options: Click on this button to display payment options buttons on the Invoice Screen.  Click 
on the button again to remove the buttons. 
 

 
 
Options: Click on this button to display the Options menu.  See Chapter 1: Setting Up Cash Register 
Express: Options Menu for more information on this screen. 
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Current Customer 
 

 
 
The default customer for each invoice is 101 Cash Customer.  You can also keep track of your customers 
by creating a customer number for each customer and then selecting it for the current invoice (creating a 
customer is explained in detail in Chapter 3: Customer Control).  There are two ways to select a 
customer for an invoice, Quick Search and Find.  Quick Search allows you to select a customer by 
entering his number while Find allows you scroll through your customer records.   
 
To select a customer for the current invoice when you know the customer number: 
 

? ? Click on Quick Search or press <ALT–K>. 
 

? ? Type in the customer number, then press <ENTER> or click on OK. 
 
? ? If the customer number is valid, that customer will appear in the current customer box. 

 
To select a customer for the current invoice when you don’t know the customer number: 
 

? ? Click on Find or press <ALT–I>. 
 
? ? Click on Next or Previous (or use <ALT–N> and <ALT–P>) to scroll through the customer 

records. 
 
? ? Once the desired customer’s record is displayed, click on Select or press <ALT–L> to select 

the customer. 
 
? ? Click on Exit or press <ALT–X> to exit without selecting a customer. 
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Traditional Invoice Screen 
 
Item Search 

 
 

Item Search is the section of the Invoice Screen where you ring up the items that the customer wants to 
purchase.  You can search for inventory items by item number or by item name.  You can set this 
parameter by selecting Inventory/Kit Sorting Order from the Inventory menu. 
 
To add an item to the current invoice using the bar code scanner, scan the bar code of an inventory item 
when the cursor is blinking in the Search by Item Number box.  The number will appear on the grid.  If 
you are entering the number by hand, you must press <ENTER> after typing the number.  You can also 
partially enter an item number and then press the down arrow key <? > to get a listing of all items 
beginning with those numbers.  For example, if you know that the item number of a can of Coke begins 
with 0112 but don’t know the rest, you can type 0112 then press <? > and all the items whose numbers 
begin with 0112 will be displayed. 
 
If the quantity for an item you are adding to the invoice is different than one, you may change it prior to 
scanning or entering the item by pressing <ALT-Q> or clicking on the Quantity box.  Note that the 
quantity can be negative and it does not need to be a whole number.  If the customer is returning an 
item, use a negative quantity.  This will add a negative amount to the current total as well as 
properly update the in-stock amount of the inventory item once the transaction is completed. 
 
 
Totals 
 

 
 

 
 
 
 
 
 
 
 
 
 

Running totals are kept for the current invoice.  Each time you add a new inventory item to the invoice, 
the totals portion is updated.  If you are using a pole display, it will be updated as well. 
 
Grand Total: This line displays the invoice total after taxes but before any invoice discounts. 
 
Sub Total: This line displays the total amount of all the items in the invoice added together before taxes 
or discounts. 
 
Tax (1st): This line displays the total amount of tax for the invoice before any invoice discounts. 
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Disc %:  This line displays the discount percentage applied to an entire invoice.  This line only appears 
when the discount is applied to the entire invoice by selecting Invoice Discount from the Invoice menu or 
pressing <CTRL-D>.  
 
Disc Total: This line displays the new Grand Total due to the invoice discount percentage.  
 
Tax (2nd): This line displays the total amount of tax for the invoice after any invoice discounts. 
 
D Total: This line displays the invoice total after taxes and invoice discounts.   
 
 
Invoice Grid 

 
The Invoice Grid shows all of the items that are in the current invoice.  It is located in the bottom half of 
the Invoice Screen.  Five columns are always in view: Item #, Description, Quantity, Price, and 
Extended.  Scrolling to the right by clicking on the right arrow in the bottom right-hand corner of the 
grid reveals additional information about the item, such as the tax, discount levels, serial number, and 
bonus points.   NOTE: A cashier can only scroll to reveal additional information about an item if both 
Add Inventory/Kits and Update Inventory/Kits are set to “Yes” in the Permissions tab of the 
Employee Maintenance screen. 
 
If you need to change information on an invoice, press <CTRL–G> to move the cursor to the invoice 
grid, then use the arrow keys to move to the invoice you wish to change.  You may change the quantity or 
price of an item, or you can delete the item by pressing <CTRL–DEL>. 
 
 
Invoice Options 
 
End Transaction: 

 
 
Once all of the items have been added and you have selected the payment method (cash is the default), 
press <ALT-E> or click on End Transaction to complete the invoice. 
 
Void Invoice: To void the current invoice, select Void This Invoice from the Invoice menu or press 
<CTRL-V>. 
 
Hold Invoice: This function allows you to place the current invoice on hold.  To place an invoice on hold, 
select Put Invoice On Hold from the Invoice menu or press <CTRL-H>.  You will be prompted to enter 
an On Hold ID of up to 4 characters to use later to recall the invoice.  NOTE: To recall an on hold 
invoice, select Recall Invoice from the Sales Information menu.  You will be prompted to enter the Hold 
ID that you originally entered when you placed the invoice on hold. 
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Current Customer 
 

The default customer for each invoice is 101 Cash Customer.  You can also keep track of your customers 
by creating a customer number for each customer and then selecting it for the current invoice (Creating a 
customer is explained in detail in Chapter 3: Customer Control).  There are two ways to select a 
customer for an invoice, Quick Search and Find.  Quick Search allows you to select a customer by 
entering his number while Find allows you scroll through your customer records.  More Info displays the 
customer number, discount level, and address of the current customer.  It also gives you the option of 
having the current invoice sent to the customer’s Ship To Address.  NOTE: Cash customer cannot have 
a ship to address. 
 
To select a customer for the current invoice when you know the customer number: 
 

? ? Click on Quick Search or press <ALT–K>. 
 

? ? Type in the customer number, then press <ENTER> or click on OK. 
 
? ? If the customer number is valid, that customer will appear in the current customer box. 

 
To select a customer for the current invoice when you don’t know the customer number: 
 

? ? Click on Find or press <ALT–F>. 
 
? ? Click on Next or Previous (or use <ALT–N> and <ALT–P>) to scroll through the customer 

records. 
 
? ? Once the desired customer’s record is displayed, click on Select or press <ALT–L> to select 

the customer. 
 
? ? Click on Exit or press <ALT–X> to exit without selecting a customer. 

 
To use the Ship to Address for a customer: 
 

? ? Click on More Info or press <ALT–M>. 
 
? ? Click on the Send to Ship to Address box. 
 
? ? Click on OK, and then continue with the invoice. 

 
NOTE: In order to use the Send to Address, you must first enter one in the Customer Maintenance 
screen. 
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Payment Options 
 
Cash 

 
To choose cash as the form of payment for an invoice, click on the Cash button (Modern) or 
select Cash Payment from the Invoice menu (Traditional).  You can also press <F6> in 
either screen. 
 

Check 
 

To choose check as the form of payment for an invoice, click on the Check button (Modern) 
or select Check from the Invoice menu (Traditional).  You can also press <F7> in either 
screen. 
 

Credit Card 
 

To choose credit card as the form of payment for an invoice, click on the Credit button 
(Modern) or select Credit Card from the Invoice menu.  You can also press <F8> in either 
screen. 
 

 
Credit Card Type: Enter the information about the card being used for this invoice.  Choose the type of 
credit card (Master Card, Visa, American Express, Discover, Other, or None).  To enter the credit card 
number and expiration date, click on the field and type.  If you are using a touch screen, you may also 
press the number sign to use an on-screen number pad.  Enter the credit card number with no spaces and 
the expiration month and year as two digits. 
 
Credit Card Transaction Type: Choose Force if the card information is processed through an outside 
terminal.  You will be required to enter an approval code.  Choose Sale to process this transaction as a 
sale automatically through IC VERIFY.  Choose Credit to process this transaction as a credit through IC 
VERIFY. 
 
Once all the information has been entered, click on OK or press <ALT–O> to process the invoice as a 
credit card sale.  Click on Cancel or press <ALT–C> to exit without saving information. 
 
On Account 
 

On Account allows a customer to put the invoice on his account.  Only customers who have 
an open account can choose this form of payment. To choose On Account as the form of 
payment for an invoice, click on the Account button (Modern) or select On Account from 
the Invoice menu.  You can also press <F9> in either screen.  NOTE: You cannot choose 

On Account as a form of payment for Cash Customer #101. 
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Split Tender 
 

Split Tender allows a customer to pay for an invoice using two or more forms of payment.  To use split 
tender on an invoice, enter the amounts in the corresponding fields (Modern) or select Split Tender from 
the Invoice menu (Traditional).  Select the forms of payment by clicking on the corresponding field or 
using the shortcut keys.  Press <ALT-C> for cash, <ALT-H> for check, <ALT-R> for credit card, 
<ALT-A> for on account, or <ALT-G> for gift certificate.  Enter the amount using either the keyboard or 
the on-screen number pad.  Once you have made your selection, click on OK or press <ALT–O>.  You 
can click on Cancel or press <ALT–E> to exit without choosing a form of split tender. 
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Invoice Properties 
 

 
 
The Invoice Properties menu allows you to access different functions that are applicable to an entire 
invoice.  To access this menu, select Invoice Properties from the Options menu or press <F11>. 
 

Discount 
 
This function allows you to apply a specific discount amount to the current invoice.  To apply a discount 
percentage to an invoice, click on Discount.  Enter the discount amount as a percentage (ex: 15 for 15%), 
then click on OK or press <ENTER>.  Click on Cancel to quit without applying a discount.  To access 
this function from the Traditional Invoice Screen, select Invoice Discount from the Invoice menu or press 
<CTRL-D>. 
 

Notes 
 

Invoice Notes allow you to establish a personal relationship with each customer.  Additionally, such notes 
can be used to track specific information associated with an invoice.  These notes can be viewed whenever 
the invoice is recalled or reprinted.  To add a note to an invoice from the Modern Invoice Screen, click on 
Notes.  To access Invoice Notes from the Traditional Invoice Screen, select Invoice Notes from the 
Invoice menu or press <CTRL-T>.  You can type up to five lines with 42 characters each per note.  
NOTE: Notes can be changed for On Hold Invoices, but once an invoice is processed to completion, 
the notes cannot be changed. 
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Tax Exempt Invoice/Tax Invoice 
 
By default, Cash Register Express applies tax to each invoice.  To bypass taxing taxable items on an 
invoice from the Modern Invoice Screen, click on Tax Exempt Invoice.  To re-apply tax to an invoice, 
click on Tax Invoice.  To choose no tax for an invoice from the Traditional Invoice Screen, select No Tax 
This Order from the Tax menu or press <CTRL-X>.  To tax an invoice, select Tax This Order from the 
Tax menu or press <CTRL-O>. 
 
 

Tax Exempt Additional Items 
 
When this option is selected, additional items added to the invoice will be tax-exempt.  To access this 
option from the Traditional Invoice Screen, select Exempt Additional Items from the Tax menu. 
 
 

Last Invoice Processed 
 

 
 

This function displays the invoice number of the last invoice processed on that computer.  To access this 
screen from the Modern Invoice Screen, click on Last Inv Processed in the Invoice Properties menu.  To 
access this screen from the Traditional Invoice Screen, select Last Invoice Processed from the Sales 
Information menu or press <CTRL-F8>. 
 
 

Desired Grand Total 
 
This function allows you to manually change the grand total for an invoice.  For example, let’s say that a 
customer purchases an item and the total comes to $10.23.  The customer pays $10.00 but can’t find any 
change so you decide to just charge him the $10.00.  You can click on Desired Grand Total to change 
the grand total of the invoice to $10.00 and CRE will automatically calculate and apply the proper 
discount.  To use this function, click on Desired Grand Total in the Invoice Properties menu. 
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Non-Inventory Item 
 

 
 

This feature allows you to add an item to an invoice that is not part of your inventory.  To access this 
screen, select Non-Inventory Item from the Invoice menu (Modern) or the Inventory menu 
(Traditional).  You can also press <CTRL–N> in either Invoice Screen. 
 
To add a non-inventory item to an invoice: 
 

? ? Enter the description, cost, quantity, and price of the non-inventory item.  Click on the box next 
to the desired tax level(s) to choose the type of tax to be applied to this item.  If Auto Cost % is 
set to Yes in the Setup Screen, CRE will automatically calculate the cost once the price of the 
non-inventory item is entered. 

 
? ? Click on Add To Invoice or press <ALT–A> to add the item to the invoice.  Click on Cancel or 

press <ALT–C> to quit without adding the item to the invoice. 
 
 

Void Invoice 
 
To void the current invoice, select Void Invoice (Modern) or Void This Invoice (Traditional) from the 
Invoice menu or press <CTRL–V> . 
 
 

Generate Pull Order 
 
This feature allows you to put an invoice on hold and print an order sheet.  This feature is useful for stores 
that stock many items and only retrieve them upon purchase.  For example, if a customer places an order 
over the phone, the cashier can click on Generate Pull Order and print an order in the warehouse so that 
the items can be pulled out of stock.  The cashier can then recall the pull order when he is ready to end the 
transaction.  To use this function, select Generate Pull Order from the Invoice menu (Modern Invoice 
Screen only). 
 

Print Ticket/Voucher 
 

This feature allows you to print additional tickets or vouchers for an item (Traditional Invoice Screen 
only).  You must enter the administrator password before printing additional tickets or vouchers. 
 



Chapter 4: Creating Invoices 

Cash Register Express 94 

Steps for Invoicing an Order 
 

1. Select Customer (Chapter 4: Creating Invoices): 
 

? ? Use the default Cash Customer (#101) 
 

Or 
 

? ? Use Find or Quick Search to select a customer 
 
2. Tax (Chapter 4: Creating Invoices): 
 

? ? Use the default Tax Invoice 
 

Or 
 

? ? Select Tax Exempt Invoice 
 
NOTE: In the Traditional Invoice Screen, you must select No Tax This Order BEFORE you add 
any items to the invoice or else taxable items will be taxed. 

 
3. Select Inventory Items to be placed on the Invoice Grid (Chapter 4: Creating Invoices): 

 
You can either scan in the item number with a bar code scanner or manually enter the item number or 
item name.  If you don’t know the entire number for an item, you can type the first few characters 
then click on the down arrow to display all the items beginning with those characters.  
 
A. Select Modifiers for an item (Chapter 2: Inventory Control): 
 

 
If you selected modifiers for an item in the Inventory Maintenance screen, a screen like this will 
appear when the item is selected for an invoice.  Select modifiers by clicking on the 
corresponding boxes with the mouse or use <TAB> to move to the desired box then type ‘X’.  
Selected modifiers are indented below the item in the inventory grid. 
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B. Non-Inventory Items (Chapter 2: Inventory Control): 
 
If you wish to add a non-inventory item to the invoice grid, select Non-Inventory Item from the 
Invoice menu (Modern) or the Inventory menu (Traditional).  The Non-Inventory Item screen 
will appear.  Enter the required information, then click on Add to Invoice or press <ALT–A> to 
add the item to the current invoice.  To quit without adding an item, click on Cancel. 

 
NOTE: All items entered using the Non-Inventory Item screen will be tracked under the item 
Non-Inventory Item. 

 
4. Deleting an Item from the Invoice Grid (Chapter 4: Creating Invoices): 
 

To delete an item from the invoice, highlight the item to be deleted, and then click on Delete 
(Modern) or press <CTRL–DEL> (Modern and Traditional).  The item will be deleted from the 
invoice grid. 

 
5. Changing the Item Quantity on the Invoice Grid (Chapter 4: Creating Invoices): 
 

You may change the quantity for an item once it has been added to the invoice grid.  In the Modern 
Invoice Screen, position the cursor on the desired item then click on Quan Change.  In the 
Traditional Invoice Screen, position the cursor on the desired quantity then press <BACKSPACE>.  
Enter the correct quantity once the prompt appears, then press <ENTER> or click on OK, or click on 
Cancel to exit without changing the quantity. 

 
6. Changing the Item Price on the Invoice Grid (Chapter 4: Creating Invoices): 
 

You may change the price for an item once it has been added to the invoice grid.  In the Modern 
Invoice Screen, position the cursor on the desired item then click on Price Change.  In the 
Traditional Invoice Screen, position the cursor on the desired price then press <BACKSPACE>.  
Enter the correct price once the prompt appear, then press <ENTER> or click on OK, or click on 
Cancel to exit without changing the price. 

 
7. Repeat steps 3-6 for all items purchased. 
 
8. Invoice Notes (Chapter 4: Creating Invoices): 
 

Add notes to an invoice by selecting Notes from the Invoice Properties screen (Modern) or Invoice 
Notes from the Invoice menu (Traditional). 

 
9. Invoice Discount (Chapter 4: Creating Invoices): 
 

Apply a specific discount amount to the entire invoice by selecting Discount from the Invoice 
Properties screen (Modern) or Invoice Discount from the Invoice menu (Traditional). 

 
10. Line Discount (Chapter 4: Creating Invoices): 
 

Apply a discount to a specific line number of the invoice by clicking on Discount (Modern) or 
selecting Line Discount from the Invoice menu (Traditional) or by pressing <CTRL–L> (Both). 

 
11. Put Invoice On Hold (Chapter 4: Creating Invoices): 
 

Place an invoice on hold by clicking on Hold Invoice (Modern) or by selecting Put Invoice On Hold 
from the Invoice menu (Traditional).  You will be prompted to enter a Hold ID of up to 4 digits. 
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12. Recall On Hold Invoice (Chapter 4: Creating Invoices): 
 

To recall an On Hold Invoice, select Recall On Hold Invoice from the Cashier Functions screen 
(Modern) or the Sales Information menu (Traditional).  You will be prompted to enter the Hold ID 
that you originally entered when you placed the invoice on hold. 

 
13. Select Payment Method (Chapter 4: Creating Invoices): 
 

There are five payment methods: 
? ? Credit Card: You will be prompted to enter credit card information for the sale 
? ? Cash:  This is the default payment method. 
? ? Check:  You will be prompted to enter the check number. 
? ? Split Tender: This uses a combination of two or more payment methods. 
? ? On Account: This form of payment can only be selected if the customer has an open account. 

 
14. End Transaction (Chapter 4: Creating Invoices): 
 

Once all of the items have been added and you have selected the payment method, click on End 
Transaction or press <ALT–E> to complete the invoice. 

 
15. Amount Tendered: 
 

This is the amount of money that the customer gave to the cashier.  Enter the correct amount 
tendered, then click on OK or press <ENTER> to complete the transaction.  Click on Cancel or 
press <ALT-E> to exit without completing the transaction. 
 

16. Receipt Prompt: 
 

If Print Invoices is set to Prompt in the Setup Screen, this screen will appear.  Click on Yes or press 
‘Y’ to print a receipt, or click on No or press ‘N’ if you do not want to print a receipt. 
 
Change: 

 

This is the amount that the customer should receive back based on the amount tendered and the grand 
total of the invoice.  Click on OK, press <ENTER>, or press <ALT–O> to clear the screen for a new 
invoice. 
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Reporting Screen 
 

 
 
Cash Register Express offers you the ability to generate a wide variety of reports.  The following are brief 
descriptions of all the reports.  Many of the reports require parameters in order to run them, such as a date 
range, and most of the reports can be displayed on the screen and then printed from there.  Some reports 
can only be printed to receipt printers.  To access this screen, select Reporting Screen from the Tools 
menu (Modern) or Reports menu (Traditional) in the Invoice Screen menu bar or press <ALT–R> in the 
Invoice Screen.  Once a report is selected and the parameters are entered, click on Display or press 
<ALT-D> to view the report.  Click on Print or press <ALT-P> to print the report.  To exit without 
generating a report, click on Exit or press <ALT-X>. 
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Sales Reports 
 
Invoice Totals Report 
 
This report prints detailed information from invoice processing.  You can view an Invoice Totals Report 
for all cashiers or for a specific cashier.  You can also choose to view either complete, on hold, or voided 
invoices.  You can select any date range you wish.  To view a single day, use the same start and end date.  
The report displays the following information about an invoice: Date/Time, Invoice Number, Customer 
Number, Cashier ID, Payment Method, Total Cost, Total Price, Tax, Grand Total, and Gross Profit.  It 
also displays the total number of invoices processed and the grand totals.  To view this report, select 
Invoice Totals Report from the Reporting Screen. 
 
 
Invoice Totals by Customer 
 
This report displays all invoices in a given date range.  It is sorted by customer last name.  To view a 
single day, use the same start and end date.  The report displays the following information about an 
invoice: Customer Last Name, Customer First Name, Invoice Number, Date/Time, Customer Number, 
Total Price, and Grand Total.  It also displays the total of all invoices in the specified date range for each 
customer and a grand total of all invoices.  To view this report, select Invoice Totals by Customer from 
the Reporting Screen. 
 
 
Grand Totals by Payment Method 
 
This report breaks down the invoices by their payment methods.  To view this report, select Grand Totals 
by Payment Method from the Reporting Screen. 
 
 
Daily Totals 
 
This report is a summary of all the invoices for all cashiers for the specified date.  This report will print on 
a standard receipt printer.  To print this report, select Daily Totals from the Reporting Screen. 
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Detailed Daily Report 
 

 
 
The Detailed Daily Report (DDR) lists the sales totals for the day on a receipt printer.  You can also get a 
breakdown by payment type, accounts receivable payment type, department, or item.  You can choose to 
print for all cashiers or for a particular cashier, as well as for all stations or for a particular station.  You 
can also choose Include Costs if you have an 80 column printer.  This will print the cost, extended cost, 
gross margin, and gross margin %.  If the Line Discount Totals feature is selected, the DDR will list the 
total dollar amount of line discounts given for each department and overall.  You may also choose to List 
Vendor Payouts on the DDR (see Chapter 6: CRE Tools: Tools Menu: Vendor Payouts for more 
information on this feature). 
 
The Z-Out feature can only be used when the DDR is printed for an individual cashier.  When this 
option is selected, CRE will record the time and date of when you printed the report for that particular 
cashier.  When you next print that cashier’s DDR, CRE will default the start date and time to whenever 
you last printed the report.  The end date and time will default to the current date and time.  This ensures 
that you will always print the Z-Out for the last shift of information, with no overlap. 
 
To print this report, select Detailed Daily Report from the Reporting Screen, select the desired cashiers, 
date, and breakdown, and then click on Print or press <ALT–P>.  Click on Exit or press <ALT-X> to 
exit without printing the report. 
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Sales by Vendor 

 
This report displays a breakdown of sales during a specified date range for each item by vendor.  You can 
choose to generate this report for either a specific vendor or for all vendors.  The report displays the 
following information: Vendor Number, Date, Item Number, Item Name, Quantity, and Extended Price.  
To display this report, select Sales by Vendor from the Reporting Screen, enter the desired information, 
then click on Generate or press <ALT-G>.  Click on Exit or press <ALT-X> to exit without generating 
this report. 
 
 
Grand Totals by Date 
 

 
 
This function displays a message box with the selected day’s grand total.  To access this screen, select 
Grand Totals by Date from the Reporting Screen and enter the desired date. 
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Grand Totals by Salesperson 

 
This report prints the grand total for each salesperson for a specified date range.  You can choose to 
generate this report for either a specific salesperson or for all salespeople.  To print this report, select 
Grand Totals by Salesperson from the Reporting Screen, enter the desired information, then click on 
Generate or press <ALT-G>.  Click on Exit or press <ALT-X> to exit without printing this report. 
 
 
Grand Totals by Department 
 

This function displays a message box with the grand total for the specified department as well as the 
amount of items from that department that were sold.  To access this screen, select Grand Totals by Dept 
from the Reporting Screen, then enter the desired department, starting date, and ending date. 
 
Grand Totals by Item 

 
This function displays a message box with the grand total for the specified item as well as how much of 
that item were sold.  To access this screen, select Grand Totals by Item from the Reporting Screen, and 
then enter the item number, starting date, and ending date. 
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Grand Total of Tax Exempt Sales 

 
This function displays a message box with the total of taxed sales, the total of non-taxed sales, the total of 
tax exempt sales, and the total sales all before taxes were applied.  To access this screen, select Grand 
Total of Tax Exempt Sales from the Reporting Screen then enter the starting and ending dates. 
 
 
Daily Gross Profits 

 

 
 
This function allows you to quickly see the gross profit for the specified date.  To access this screen, select 
Daily Gross Profits from the Reporting Screen and enter the desired date. 
 
 
Check Sales 
 
This report lists the check numbers and amounts for each check sale.  This report contains the following 
information: Date, Cashier ID, Customer #, Check #, Invoice #, and Amount.  To view this report, select 
Check Sales from the Reporting Screen. 
 
 
Sales by Zip Code 
 
This report lists the number of customers in each zip code.  This report allows you to see how many sales 
were processed for each zip code, therefore generating regional sales figures.  This information can assist 
in advertising budgeting.  To view this report, select Sales by Zip Code  from the Reporting Screen.   
 
NOTE: To set up CRE to prompt you to enter a zip code at the end of each invoice, check the box 
next to Prompt Zip Code on the Invoice Settings tab of the Setup Screen. 
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Inventory Reports 
 
List Alphabetical 
 
This report displays a list of all the items in the inventory in alphabetical order by item name.  The report 
contains the following information about each item: Item Name, Item Number, Department, Cost, In 
Stock, Value, and Price.  The items on the report are divided by Department.  To view this report, select 
List Alphabetical from the Reporting Screen. 
 
 
List Numerically 
 
This report displays a list of all the items in the inventory in numerical order by item number.  The report 
contains the following information about each item: Item Number, Item Name, Department, Cost, In 
Stock, Value, and Price.  The items on the report are divided by Department.  To view this report, select 
List Numerically from the Reporting Screen. 
 
 
Reorder Report 
 
This report displays a list of inventory items that have fallen below their respective reorder levels.  The 
report contains the following information about each item: Item Number, Item Name, Item Name, 
Department, Cost, In Stock, Value, Price, Reorder Level, Reorder Quantity, Vendor Number, Company, 
and Part Number.  To view this report, select Reorder Report from the Reporting Screen. 
 
 
Matrix Quantity 
 
This report displays how many items of a particular group are in stock.  You can see how many of a 
certain color or size are in stock from this report.  To view this report, select Matrix Quantity from the 
Reporting Screen. 
 
 
Daily Itemized Sales 
 

 
 
This function displays a message box with the total number sold of a particular item on a particular date.  
To access this screen, select Daily Itemized Sales from the Reporting Screen, and then enter the item 
number and the desired date. 
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Daily Sales by Department 

 
This function displays a message box with the total number of items sold from a particular department on 
the selected day.  To access this screen, select Daily Sales by Department from the Reporting Screen, 
and then enter the department number and the desired date. 
 
 
Inventory Sales Summary 
 
This report lists a monthly breakdown of quantity sold, total cost, total sales, and gross profit for every 
inventory item.  The items are listed by item name.  To view this report, select Inventory Sales Summary 
from the Reporting Screen. 
 
 
Serial Number Sales 
 
This report lists all the serial numbers sold for a specified range of dates.  The following information is 
displayed in the report: Invoice Number, Date, Serial Number, Item Name, Item Number, and Customer 
Name.  To view this report, select Serial Number Sales from the Reporting Screen, and then enter the 
desired dates. 
 
 
Department Listing 
 
This report generates a complete listing of all the Department IDs with their corresponding descriptions.  
To view this report, select Department Listing from the Reporting Screen. 
 
 
Items by Department 

 
This report displays information about inventory in a specific department.  The following information is 
displayed in the report: Item Name, Item Number, Department, Cost, In Stock, Value, and Price.  To view 
this report, select Items by Department.  Use the mouse or the arrow keys to highlight the desired 
department.  Click on Report or press <ALT–R> to display the report.  Click on Cancel or press <ALT–
C> to exit without viewing the report. 
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Vendor Listing 
 
This report generates a complete listing of all the vendors and their corresponding vendor number.  The 
following information is displayed in the report: Vendor Number, Contact Name, Company Name, City, 
State, Zip Code, and Phone Number.  To view this report, select Vendor Listing from the Reporting 
Screen. 
 
 
Items by Vendor 
 
This report lists items for a specified vendor in numerical order by item number.  The following 
information is displayed in the report: Item Number, Item Name, Department, Cost, In Stock, Value, and 
Price.  To view this report, select Items by Vendor from the Reporting Screen then enter the desired 
vendor number. 
 
 
Current Value 

 
This function displays a message box with the current value of your inventory.  To access this screen, 
select Current Value from the Reporting Screen. 
 
 
Current Items 
 
This function displays a message box with the current number of valid items.  To access this screen, select 
Current Items from the Reporting Screen, then enter the start and end date of the desired date range. 
 
 
Received Items 
 
This report displays a list of all items received into your store via purchase orders or instant purchase 
orders.  To view this report, select Received Items from the Reporting Screen. 
 
 
Top Sellers 
 
This report lists the 25 top selling inventory items during the specified date range.  To view this report, 
select Top Sellers from the Reporting Screen then enter the start and end date of the desired date range. 
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Customer Reports 
 
Accounts Receivable Summary 
 
This report displays a summary of all customers and their current balances.  The following information is 
displayed in the report: Customer Number, Last Name, First Name, Company Name, and On Account 
Balance Due.  To view this report, select A/R Summary from the Reporting Screen.  You can choose to 
sort by Customer Number or by Last Name.   
 
 
Accounts Receivable Statement 
 
This function prints a detailed statement listing purchases and payments for either all customers or a 
specific customer.  To print a statement for all customers, select A/R Statement from the Reporting 
Screen then select All Customers.  You will be asked whether or not to print statements for customers 
that have a total balance due of $0.00 and to enter the starting date of transactions.  To print a statement 
for a specific customer, select A/R Statement from the Reporting Screen and choose Specific Customer, 
then enter the customer number.  NOTE: Invoices that have been fully paid appear on the statement 
for 30 days. 
 
 
Aging By Company 
 
This report displays a list of all customers, their current balances, and for how long the balances have 
been outstanding.  Overdue balances for each customer are listed in periods of 1-30 days, 31-60, 61-90 
and 90+.  To view this report, select Aging By Company from the Reporting Screen. 
 
 
Membership 
 
This report generates a list of all the customers who have an active club membership.  The report lists the 
Customer Number, Full Name, and Membership Expiration Date.  To view this report, select 
Membership from the Reporting Screen. 
 
 
Purchasers of Item 
 
This report displays a list of all customers who purchased a specific item.  The following information is 
displayed in the report: Date, Time, Customer Number, First Name, and Last Name.  To view this report, 
select Purchasers of Item from the Reporting Screen. 
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Sales History 
 
 

This report displays the sales history of either all customers or a specific customer for a specified range of 
dates.  The report shows every invoice and every item sold to the customer along with how many bonus 
points were earned.  Each customer record appears on a separate page.  To view this report, select Sales 
History from the Reporting Screen.  Enter the start and end date, select either all customers or enter a 
specific customer number, and then click on Display or press <ALT-D>.  Click on Exit or press <ALT-
X> to exit without viewing the report. 
 
 

Most Frequent Buyers 
 
This function displays a message box with the top ten frequent buyers for a specified date range.  To 
access this screen, select Most Frequent Buyers from the Reporting Screen, then enter the start and end 
date of the desired date range. 
 
 

Phone Listing 
 
This report generates a list of customers and their phone numbers.  You can sort the list by either 
customer number or customer last name.  The following information is displayed in the report: Customer 
Number, Last Name, First Name, Company Name, Phone Number, and Alternate Phone Number.  To 
print a Customer Phone List by Customer Number, select Phone Listing from the Reporting Screen, type 
‘1’, then click on OK or press <ENTER>.  To print a Customer Phone List by Customer Last Name, 
select Phone Listing from Reporting Screen, type ‘2’, then click on OK or press <ENTER>. 
 
 

Ship To Info 
 
This report generates a list of customers and their Ship To addresses.  All customer information, including 
credit card information, is printed.  To print this report, select Ship To Info from the Reporting Screen. 
 
 

Customer Referral 
 
This report allows you to view a listing of all the referral sources for your customers.  To view this report, 
select Customer Referral from the Reporting Screen.  For more information on this feature, see 
Chapter 3: Customer Control. 

Employee Reports 
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Hours and Wages 

 
This report displays the total wages earned and tips collected in a specified date range.  You can choose to 
generate this report for a specific cashier or employee department.  To display this report, select Hours 
and Wages from the Reporting Screen, enter the desired information, then click on Generate or press 
<ALT-G>.  Click on Exit or press <ALT-X> to exit without generating this report. 
 
 
Server Tips 
 
This report lists all of the server tips for credit card purchases during a specified time range.  The report 
lists the Server ID, Date, Time, Invoice #, and Tip Amount and is sorted by Server ID.  To view this 
report, select Server Tips from the Reporting Screen. 
 
 
Commissions 
 
This report lists all of the commissions earned by a salesperson.  This report lists the Salesperson ID, 
Date, Invoice #, Total Price, and Commission.  To view this report, select Commissions from the 
Reporting Screen. 
 

Restaurant Reports 
 
Number of People Served 
 
This function displays a message box showing how many people were served within a specified time range 
when recorded through touch screen invoicing in Restaurant Pro Express.  You will be prompted to enter 
the start date and the end date of the desired range.  To access this screen, select # of People Served from 
the Reporting Screen 
 
 
Server Tips 
 
This report lists all of the server tips for credit card purchases during a specified time range.  The report 
lists the Server ID, Date, Time, Invoice #, and Tip Amount and is sorted by Server ID.  To view this 
report, select Server Tips from the Reporting Screen. 
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Rental Reports 
 
Late Rentals 
 
This report lists rentals that are currently overdue.  To print this report, select Late Rentals from the 
Reporting Screen. 
 
 
Currently Rented 
 
This report lists items that are currently rented.  The following information is displayed in the report: Item 
Number, Item Name, and the Customer Number, Customer Name, and phone number of the customer 
currently renting the item.  To view this report, select Currently Rented from the Reporting Screen. 
 
 
In Store 
 
This report lists rental items that are currently in the store.  The following information is displayed in the 
report: Item Number, Item Name, and the Customer Number, Customer Name, and phone number of the 
last customer to rent the item.  To view this report, select In Store from the Reporting Screen. 
 
 
History 
 

This function displays the rental history of a rental item.  The top grid contains the following information: 
Date the item was rented, Invoice Number, Customer Number that rented the item, and Price.  The bottom 
grid contains the following information: Item Number, Total Number of times that the item has been 
rented, and the total amount of money from the rental (not including tax).  To view this screen, select 
History from the Reporting Screen.  Click on Select or press <ALT–S> then enter the item number.  
Click on Exit or press <ALT–X> to exit the Rental History screen. 
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Sample Report 

 
 

The above is a sample Cash Register Express report.  At the top of each report view screen there are 
several command buttons with specific functions: 
 

Use these buttons to go to the first and last pages of the displayed report. 
 

 
Use these buttons to the previous or next page of the displayed report. 
 

 
Click on this button to print the current report.  You may print the whole report or a selection of 
pages. 

 
Click on this button to export your report to another program.  The following are your choices of 
format: Lotus 1-2-3 spreadsheet, Excel spreadsheet, Word for Windows, Crystal Reports, Data 

Interchange Format, HTML, Record Style, character-separated values, comma-separated values, paginated 
text, rich text format, text, tab-separated values, and tab-separated text.  You must save the export file as a 
disk file (default) or Microsoft Mail (MAPI). 
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Tools Menu 
 

Modern 
 

 
 

Traditional 
 

 
The Tools menu contains several tools to use with Cash Register Express.  To access this menu, click on 
Tools in the Options menu (Modern) or on the Invoice Screen Menu Bar (Traditional). 
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ASCII Transfer 
 

Import Inventory 

 
 
Import Inventory allows you to import delimited or non-delimited text.  The text must in the following 
order: Item Name, Item Number, Cost, In Stock, Price, Department, and Retail Price.  You are also 
allowed to select a default tax rate for all the items being imported.  To import text, select ASCII 
Transfer from the Tools menu.  To use a delimiter, click on the box next to Delimiter Used or press 
<ALT-D>.  Choose either Replace in Stock or Add to In Stock by clicking on the appropriate circle or 
pressing <ALT–R> for replace or <ALT–A> for add.  Click on Import or press <ALT–I> to import the 
text.  You will be prompted to choose a tax rate and to choose your import file. 
 
 
Export Inventory 

 
 
Export Inventory allows you to export invoice information to another program.  Enter a start date and an 
end date for the invoices you would like to export, then choose to export either all invoices or payment or 
only those invoices or payments that haven’t yet been exported.  Click on Export or press <ALT–E> to 
export the selected invoice information. 
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Import Account Adjustments 

 
 
Import Account Adj allows you to import customer account balances and balance adjustments from 
another program.  Choose Overwrite to overwrite the current account balance information with the 
imported information, or you can choose Adjust to adjust the current account balance information based 
on the imported information.  Click on Import or press <ALT–I> to import the customer balance 
information. 
 
 

Labor Scheduling 

 
 

Labor Scheduling allows you to create work schedules for your employees in CRE. 
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Schedule 
 
To schedule an employee: 
 

? ? Select a day by clicking on a day on the calendar. 
 
? ? Click on Schedule or press <ALT-S>. 

 
? ? Enter the desired information then click on Done or press <ALT-D>. 

 
 
Unschedule 
 
To unschedule an employee: 
 

? ? Click on the event that you wish to cancel. 
 

? ? Click on Unschedule or press <ALT–U> to unschedule the employee. 
 
 
View Schedule 
 
To view a day’s schedule: 
 

? ? Select a day by clicking on a day on the calendar. 
 
? ? Choose which schedules to display, either Employees in Department or Specific Employee. 

 
? ? Select ALL to display all employees in all departments, or select a specific department or 

employee to display. 
 

? ? The Employee ID, Start Time, End Time, and Hour/Min for the selected employees will appear 
in the grid. 
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Palm Invoicing 
 

Palm Invoicing allows for remote invoicing.  You can do invoicing away from a computer and then 
transfer data to the main database at a later time.  To use this function, select Palm Invoicing from the 
Tools Menu. 
 
 

Load Current Palm Pilot Invoice 
 
This function allows salesman to do invoicing on the go with their Palm Pilot and transfer all their 
invoices to CRE 2000 when they return.  To use this function, select Load Current Palm Invoice 
(Modern) or Load Current Palm Pilot Invoice (Traditional) in the Tools Menu. 
 
 

Send Inventory to Palm Pilot 
 
This function allows you to import your inventory onto a Palm Pilot.  To use this function, select Send 
Inventory to Palm (Modern) or Send Inventory to Palm Pilot (Traditional) in the Tools Menu. 
 
 

Send Customers & Cashiers to Palm Pilot 
 
This function allows you to import your customers and cashier IDs to a Palm Pilot.  To use this function, 
select Send Cust/Cashier to Palm (Modern) or Send Customers & Cashiers to Palm Pilot (Traditional) 
in the Tools Menu. 
 
 

Wage Calculator 

 
Wage Calculator allows you to calculate an employee’s wages for a specified range of dates based on the 
hourly wage entered in Employee Maintenance.  To calculate an employee’s wages, select Wage 
Calculator from the Tools Menu, select the employee, enter the tax rate and range of dates, then click on 
Calculate or press <ALT-C>.  Click on Exit or press <ALT-X> to exit without calculating wages. 
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QuickBooks Sales Totals Pass 
 

The QuickBooks Sales Interface allows you to pass sales and tax totals to QuickBooks.  A separate pass 
file is generated for each day or range of days selected.  To access this screen, select Quick Books Sales 
Pass from the Tools menu (Modern) or Quick Books Sales Totals Pass from the Sales Information 
menu (Traditional). 
 
You must define your QuickBooks accounts and names through Quick Books Setup in the Setup menu 
prior to creating your QuickBooks import files.   
 
History of each day’s sales and tax totals passed is maintained for your review.  Import files are placed in 
your CRE2000 directory as an .IIF file.  These files may be deleted once you have imported them to 
QuickBooks. 
 
 
History – Sales Totals Passed to Quick Books 
 
This grid displays the QuickBooks import files that have been created.   
 
Date: This is the date that the import file was created. 
 
QB File Name: This is the location and name of the import file. 
 
CRE Undep. Funds: This is the amount of undeposited funds. 
 
CRE Sales Income: This is the amount passed to Sales Income. 
 
CRE Sales Tax: This is the amount passed to Sales Tax. 
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Pass Sales Totals 
 
Date: This is the date that the CRE Sales and Tax were accumulated for the Import File. 
 
CRE Sales Income: This is the amount that will be passed to Sales Income. 
 
CRE Sales Tax: This is the amount that will be passed to Sales Tax. 
 
CRE COGS-Info Only: This is the Cost of Goods Sold for this day’s sales.  It is an information only field 
and is not passed to QuickBooks. 
 
Start Date: This is the beginning date for which you wish to create sales total import files. 
 
End Date: This is the end date for which you wish to create total import files. 
 
 
Control Buttons 
 
Select: This button selects sales information for the specified date range and places this information in the 
Pass Totals grid. 
 
Create QuickBooks File: This button creates a separate import file for each pass file in the Pass Sale 
Totals grid.  These files are stored in the CRE directory as an .IIF file.  This also creates a history record 
indicating that a file was created on this date.  NOTE: CRE uses the following notation for naming 
QuickBooks files: QB<ddmmyy>.IIF.  If the specified date range were September 1, 1998 through 
September 3, 1998, CRE would create three files: QB010998.IIF, QB020998.IIF, and QB030998.IIF. 
 
Cancel: This button clears the Pass Sales Totals grid. 
 
Invoke QuickBooks: This button loads QuickBooks so you can import the files created. 
 
Exit: This button exits the QuickBooks Interface screen. 
 
 
To create a QuickBooks file: 
 
? ? Enter the Start Date and the End Date of the desired range. 
 

? ? Click on Select or press <ALT–S> to place an entry in the Pass Sales Totals grid for each day in 
the specified range. 

 
? ? Click on Create QuickBooks File or press <ALT–B> to create a QuickBooks file for each day 

in the specified range.  You can verify that the file was created in the History – Sales Totals 
Passed to QuickBooks grid.  NOTE: Every QuickBooks file that you create will be stored in 
the History grid for reference purposes. 
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Scheduler 
 

 
 
Scheduler allows you to schedule events under different Cashier IDs.  To use this function, select 
Scheduler from the Tools menu. 
 
 
Select Specific Date  
 
Select this option to move to a specific date on the calendar (Example: 7/2/01 for July 2, 2001) 
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Schedule Event 
 
To schedule an event: 
 

? ? Select a day by either clicking on a day on the calendar or selecting a date using Select Specific 
Date. 

 
? ? Select the start time of the event by clicking on the appropriate box under the desired Cashier ID. 

 
? ? Click on Schedule Event or press <ALT–S>.  This screen will appear. 

 
? ? Select a customer by clicking on S or by pressing <ALT–S>.  Then enter the correct end time of 

the event and description. 
 

? ? Click on OK or press <ALT–O> to schedule the event or click on Cancel or press <ALT-C> to 
exit the screen without scheduling an event. 
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Unschedule Event 
 
To unschedule an event: 
 

? ? Click on the event that you wish to cancel or use the arrows to highlight the desired event. 
 

? ? Click on Unschedule Event or press <ALT–U> to unschedule the event. 
 
 
Mass Unschedule 
 
Mass Unschedule unschedules all past scheduled events.  To do this, click on Mass Unschedule or press 
<ALT – M>. 
 
 
 

Send Data to Host 
 

This function allows you to automatically e-mail invoice export files created through the ASCII Transfer 
screen to the address specified in the Internet Features tab of the Setup Screen.  To access this function, 
select Send Data to Host (Modern) or Send to Host (Traditional) from the Tools Menu.  Click on Send 
Now or press <ALT-S> to send a file immediately.  To send the file at a later time, click on Export 
Information At, enter the desired time for transfer, then click on Activate Timer or press <ALT-A>. 
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Vendor Payouts 

 
This function allows you to pay vendors on the fly with cash from the cash drawer when they deliver 
shipments to your store.  CRE will deduct the amount paid from cash in the Detailed Daily Report (DDR).  
You can also choose to list vendor payouts in the DDR (see Chapter 5: Reports: Reporting Screen: 
Sales Reports: Print Detailed Daily Report for more information).  To use this function, select Vendor 
Payouts from the Tools menu. 
 
 

Serial Number Tracking 
 

This function allows you to track a serial number for an item that was purchased.  To track a serial 
number, select Serial Number Tracking from the Tools menu, click on Track, enter the serial number, 
then click on OK or press <ENTER>.  The serial number will appear, as well as the associated item 
number, item name, price, invoice number, date that the invoice was processed, and the customer who 
purchased the item.  If the serial number has been used more than once, you can use Next and Previous to 
track all the occurrences of that serial number until the correct one is displayed. 
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Setting Up IC Verify for DOS in Windows 95 
or 98 to work with Cash Register Express 

 
1. Click on the Start button and select Run.  Type command to go to the DOS prompt. 
 

? ? Type CD\ at the DOS prompt to go to the root directory (C:\). 
 
? ? Type MD\MULTI to create a directory called C:\MULTI. 

 
2. Type CD\ICVERIFY to relocate to the ICVerify directory. 
 

? ? Type ICVerify to run ICVerify, then test the program by running a credit card through ICVerify.  
Test ICVerify without Cash Register Express running to be sure that the program is running 
properly by itself. 

 
NOTE: If there are problems running ICVerify in DOS, ICVerify will not work properly with 
Cash Register Express. 
 
? ? Type exit to exit from the DOS prompt and return to Windows. 

 
3. Create a shortcut for ICVerify on the Windows Desktop.   
 

? ? Right click on the desktop to display a menu of options for the desktop. 
 

 
? ? Select New then select Shortcut. 
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? ? For the command line, type c:\icverify\icverify.exe /n/o/m c:\multi, then click on Next. 
 

 
4. Launch Cash Register Express.  At the Login Screen, click on Setup then select Setup File 

Locations.  You will be asked to enter the drives that the CRE database, Windows, and IC Verify are 
on.  Be sure that the drive specified for IC Verify is the same as the one the IC Verify is actually on.   

 
? ? Launch IC Verify in Windows then launch Cash Register Express.  Test that IC Verify works 

with CRE by processing a credit card transaction. 
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Setting Up IC Verify for Windows 95 or 98 to 
work with Cash Register Express 

 
1. Load the IC Verify Setup program. 
 

? ? Click on Start, and then select Programs, IC Verify for Windows then IC Verify Setup. 
 
2. Click on Merchant Information and make sure that Evaluate Rsp is set to ‘Y’ for short response.  

Save the changes, then exit. 
 
3. Load the IC Verify Multi User Processor. 
 

? ? Click on Start then select Programs, IC Verify for Windows then IC Verify Multi User.  
Make sure that the Request Directory is set to C:\MULTI. 

 

 
 

4. Click on Initialize and wait for IC Verify to report DLL Successfully Initialized.  Run Cash Register 
Express without exiting the IC Verify Multi User File Processor.  Cash Register Express is now 
ready to work with IC Verify. 
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Log-In Screen 

 
 

The first screen that appears when you run Restaurant Pro Express is the Log-in Screen.  To log in to 
Restaurant Pro Express, enter your Server ID and Table #, then click on Enter or press <ALT-E>.  
Click on Delete or press <ALT-D> to backspace or click on Clear or press <ALT-C> to clear the entire 
field. 
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File Menu 
 

 
 
Several of the functions listed in the Restaurant Pro Express File menu have the same functionality in 
Cash Register Express. 
 
For more information on the following functions, see Chapter 1: Setting Up Cash Register Express: 
File Menu: 
 

? ? Select Industry 
? ? Select Database Location 
? ? Compact & Repair Database 
? ? Check Database 
? ? Clear Database 
? ? Employee Maintenance 
? ? Change Passwords 
? ? Add Station 
? ? Register 

 
For more information on Setup Screen, see Chapter 1: Setting Up Cash Register Express: Setup 
Menu: Setup Screen. 
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Set Station ID 
 

This function allows you to set station IDs for different stations once they have been created using Add 
Station.  To access this function, select Set Station ID from the File menu.  For more information on 
adding station IDs, see Chapter 1: Setting Up Cash Register Express: File Menu: Add Station. 
 
 

Order Filling 
 

This screen displays all orders sent to this Station ID as designated in the Printers tab of Inventory 
Maintenance.  Each tile shows a different invoice and they are displayed in the order in which they were 
placed.  When an order has been completed, click on No Order or the corresponding number or press 
<ALT-#> to remove it from the active orders. 
 
 

View Options Screen 
 
This function allows you to view the Options Screen for more setup options.  These options include: 
adding inventory (See Chapter 2: Inventory Control) and adding customers (See Chapter 3: Customer 
Control).  To display the Options screen, select View Options Screen from the File menu. 
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Invoice Screen 
 

 
 
The Invoice Screen is where all of your daily invoicing will be done.  Administration tasks such as 
Reports, Accounts Receivable, Purchase Orders, and Inventory Control are performed in different 
screens.  Select View Options Screen from the File menu in the Log-In screen to access these functions.  
Further explanations on these functions can be found in earlier chapters. 
 
Before you begin processing invoices, you must manually enter your inventory items into RPE. You may 
want to enter just a few items at first so you can get a feel of how the program works, and then 
progressively add more items.  Refer to Chapter 2: Inventory Control for more information on adding 
inventory items. 
 
NOTE:  For Restaurant Pro Express, all items MUST be entered into a department to appear on the 
Invoice Screen. 
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Dissecting the Invoice Screen 
 
Totals 

 
Running totals are kept for the current invoice.  Each time you add a new inventory item to the invoice, 
the totals portion is updated.  If you are using a pole display, that will be updated as well.  The top number 
is the Grand Total.  This line displays the invoice total after taxes.  The second line is the Tax Amount.  
This line displays the total amount of tax for the entire invoice. 
 
 
Invoice Grid 

 
The Invoice Grid shows all of the items in the current invoice.  The first column shows the item 
description.  The second column indicates the quantity of that item, and the third column indicates the 
total price for that line.  Use the arrows on the side of the grid to scroll up and down.  The selected line of 
the invoice is highlighted yellow.  To select a line, use the Prev and Next buttons below the grid to move 
the marker to the desired line or click on the desired line with the mouse. 
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Departments 

 
All of the departments are listed in alphabetical order on the left side of the screen.  Up to seven 
departments can be displayed on the screen at one time.  Use the corresponding Prev and Next buttons to 
scroll up and down through the list of departments.  To select a department, press the desired button.  
Once the department is selected, the button will be a lighter color and all the items in that department will 
appear on the screen. 
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Items 

 
Once a department has been selected, all of the items in it will be displayed.  Up to twenty-one items can 
be displayed on the screen at one time.  Use the corresponding Prev and Next buttons to scroll left and 
right through the list of items. 

 
To select an item, press the desired button.  Once an item has been selected, it will appear on the Invoice 
Grid.  NOTE: To enter a multiple quantity for an item, you must press the # button and enter the 
appropriate quantity BEFORE selecting the item.  For more information on the # button, see the 
following section. 
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Additional Invoice Screen Buttons 
 

Delete: Click on this button to delete a line from the current invoice.  To delete a line, use 
Prev and Next to highlight the desired line, then click on the Delete button.  You will be 
prompted to enter the administrator password before being able to delete a line. 
 

 
Line Discount: Click on this button to discount a line in the current invoice.  To discount a 
line, use Prev and Next to highlight the desired line, then click on the Line Discount button.  
Enter the percentage (not the decimal value) to be discounted then press OK to apply the 
discount.  If you make a mistake, you may press Clear to re-enter a percentage or press Cancel 

to exit the screen without applying a discount. 
 

Quantity: Click on this button to enter a multiple quantity for an item. Enter the desired 
quantity then press OK.  If you make a mistake, you may press Clear to re-enter an amount or 
press Cancel to exit without choosing a quantity.  Once the quantity has been entered, select the 
desired item.  NOTE:  You must enter the appropriate quantity BEFORE selecting the 

item. 
 

Extra Item: Click on this button to add a non-inventory item to the invoice.  Enter the dollar 
amount of the non-inventory item then press OK to add the item to the invoice.  If you make a 
mistake, you may press Clear to re-enter an amount or press Cancel to exit the screen without 
adding an item.  The item will appear as Extra Item in the Invoice Grid. 

 
Customer: Click on this button to select a customer for the current invoice.  This will bring up 
the customer selection screen: 
 
 

 
To search for a customer, partially enter a customer number and then press the down arrow key <? > to get 
a listing of all customers beginning with those numbers or letters.  You can also use the left and right 
arrows to scroll through your customers.  Click on Select to select the customer for the current invoice.  
You can also click on Add or Edit to open the Customer Maintenance screen (See Chapter 3: 
Customer Control). 
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Invoice Discount: Click on this button to discount an entire invoice.  Enter the discount 
percentage (not decimal) for the invoice.  Press OK to apply the invoice discount or press 
Cancel to exit without applying a discount.  Press Clear to re-enter a percentage. 
 

 
Check: Click on this button to print a check for the current invoice. 
 
 
 

 
Time: Click on this button to clock in or clock out.  For more information on this function, see 
Chapter 6: CRE Tools: Clock In/Clock Out. 
 
 

 
Mark for Split: Highlight the desired item then click on this button to select the items to split 
onto another check using the split check feature. 
 
 

 
Split Check: Click on this button to split the current check into multiple checks in the instance 
that the customers decide to pay separately.  NOTE: The items highlighted using the Mark 
for Split option will be moved onto a new check. 
 

 
 
 

Option 
 
 
 

 
Click on this button to view more additional options – Last Receipt, Open Drawer, and Party Size. 

 
 
Last Receipt: Click on this button to print a copy of the last receipt printed at this station. 
 
Open Drawer: Click on this button to open the cash drawer.  You will be prompted to enter the 
administrator’s password. 
 
Party Size: Choose this option to enter the number of people in the party for the current invoice. Enter 
the correct number of people then press OK.  If you make a mistake, you may press Clear to re-enter an 
amount or press Cancel to exit the screen without entering a party size. 
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Done 
 
 

 
Click on this button to display options for exiting the invoice screen – Hold, Void Invoice, Last Receipt, 
and Exit. 

 
End Transaction: Click on this button to end a transaction.  If Prompt Amount Tendered is set to Yes 
in the Setup Screen, the amount tendered screen will appear: 

 
Enter the amount tendered in the correct field(s) (Cash, Check, Credit Card, On Account, or Gift 
Certificate).  You can enter the amount using either the keyboard or the on-screen number pad.  Once 
you have made your selection, click on OK or press <ALT–O>.  You can click on Cancel or press 
<ALT–E> to exit without ending the transaction. 
 

Amount Due: This is the amount due from the customer for the current invoice. 
 

Amount Tendered: This is the payment received from the customer. 
 

Amount Remaining: This is the amount still due on the invoice.  Parentheses indicate a negative 
amount remaining (i.e. change to the customer). 
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Void Invoice: Click on this button to void the current invoice.  You will be prompted to enter the 
administrator password. 
 
Last Receipt: Click on this button to print a copy of the last receipt printed. 
 
Exit: Choose this option to exit the RPE Invoice Screen and return to the RPE Log-In Screen. 
 
 

Payment Options 
 
 
 

Click on this button to display payment options for the current invoice –CC Info, On Account, No Tax 
This Order. 

 
CC Info: Click on this button to choose Credit Card as the form of payment for the current invoice.  You 
will be prompted to enter the credit card information. 
 
No Tax This Order:  Click on this button if tax should not be applied to the current invoice. 
 
On Account: Click on this button to choose On Account as the form of payment for the current invoice.  
You must select a customer before choosing this option. 
 
 

Hold 
 
 

 
Click on this button to place the current invoice on hold.  You will be returned to the Restaurant Pro 
Express Log-In screen. 
 
 
Invoice Information 

 
This box shows information about the current invoice – Table #, Server ID, and Party. 
 
Table #: This is the table number where the party is seated. 
 
Server ID: This is the Server ID of the employee serving this party. 
 
Party: This is the party name.  If a customer is selected, the customer’s last name will appear here, 
otherwise N/A. 
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Restaurant Invoicing Tips 
 
Server IDs 
 

? ? When assigning Server IDs, make sure that they are easy to remember, such as the server’s 
initials. 

 
Item Numbers 

? ? When assigning item numbers to items, have all similar items start with the same number.  
For example, have all burgers start with 1000 (Hamburger – 1000, Cheeseburger – 1001, 
BLT – 1002, etc.).  This will make reports much more organized and easier to read. 

 
Departments 

? ? When assigning a department ID to a department, select a number that is similar to the items 
in that department.  For example, if you were to create a department called “Burgers”, you 
would assign it Department ID 1000 since all of the burgers have item numbers that begin 
with 1000. 
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A Quick Tutorial of Cash Register Express 
 

This quick tutorial is designed to familiarize you with Cash Register Express.  For this tutorial, we will be 
adding inventory, departments, and customers for a fictitious company.  We will also process some 
transactions to get a feel for the invoicing process. 
 
 

Add a Department 
 

1. To add a department, select Department Maintenance from the Administrative screen in the 
Options menu (Modern) or from the Inventory menu (Traditional). 

 
2. A window entitled Department Maintenance will appear on your screen, as shown below: 

 
3. Click on Add. 
 
4. For Department ID, enter 1000. 
 
5. Use <TAB> to move from Department ID to Department Description. 
 
6. For Department Description, enter Hardware. 
 
7. Choose the Department Type as Regular. 
 
8. Click on Save.  You have just entered a department. 
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Add a Vendor 
 

1. To add a vendor, select Vendor Maintenance from the Administrative screen in the Options menu 
(Modern) or from the Inventory menu (Traditional). 

 
2. A window entitled Vendor Maintenance will appear on your screen, as shown below: 

 
3. Click on Add. 
 
4. For Vendor Number, enter 1000. 
 
5. Press <TAB> to move the cursor to the Company Name field.  Type PC America. 
 
6. Press <TAB> to move the cursor to the Contact First Name field.  Type John.  Press <TAB> to 

move the cursor to the Contact Last Name field then type Smith. 
 
7. Press <TAB> to move the cursor to the Address fields.  Type 60 North Harrison Ave. in Street 

Address and Suite 40 in Extended Address.  Move the cursor to the City field then type Congers.  
Move the cursor to the State and Zip Code fields then type NY and 10920. 

 
8. Move the cursor to the Telephone Number field then type 800-722-6374.  Press <TAB> to move the 

cursor to the Fax Telephone Number field then type 914-267-3550. 
 
9. Click on Save.  You have just added a vendor. 
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Add an Inventory Item 
 

1. To add inventory, click on the Inventory menu, then select Inventory Maintenance.  The screen 
below should appear: 

 

 
 
2. Click on Add. 
 
3. Click on the department that you created earlier in Department Maintenance. It is listed in the 

Department field at the upper left-hand corner of the screen. 
 
4. Press <TAB> to move the cursor to the Item Number field, or click on that field with the mouse.  

Type 101. 
 
5. Press <TAB> to move the cursor to the Description field.  Type Buzzsaw. 
 
6. Press <TAB> to move the cursor to the Cost field.  The Cost is how much the item cost to purchase 

from the vendor.  Type 175.00. 
 
7. Press <TAB> to move the cursor to the Price field.  The Price is for how much the item is being 

sold.  Type 275.00. 
 
8. Press <TAB> to move the cursor to the Retail Price field.  The Retail Price is a reference field.  It 

can be used to record how much the item in question is going for in the market.  Type 300.00. 
 
9. Press <TAB> to move the cursor to the In Stock field.  This field specifies how much of the item you 

have in stock.  Type 100. 
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10. Click on Tax 1. 
 
11. Select the vendor that you added in Vendor Maintenance by clicking on it or using the arrow keys to 

highlight it. 
 
12. Press <TAB> to move the cursor to the Reorder Level field.  This field specifies how much the In 

Stock amount should be reduced to before needing to reorder this item.  Type 25. 
 
13. Press <TAB> to move the cursor to the Reorder Quantity field.  This field specifies how much of 

the item should be reordered at a time.  Type 50. 
 
14. Click on the other tabs to display more options for an inventory item.  Enter information as needed.  

Once you have finished entering all the information for an item, click on Save.  You have just added 
an item to your inventory. 
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Add a Customer 
 

1. To add a customer, select Customer Maintenance from the Invoice menu (Modern) or the Customer 
menu (Traditional).  The Customer Maintenance screen, shown below, should appear: 

 

 
 
2. Click on Add. 
 
3. Assign a Customer Number in the Customer Number field.  It is recommended that you use the 

customer’s telephone number.  For this customer, type 2673500. 
 
4. Press <TAB> to move the cursor to the First Name field.  Type John. 
 
5. Press <TAB> to move the cursor to the Last Name field.  Type Smith. 
 
6. Press <TAB> to move the cursor to the Company Name field.  Type PC America. 
 
7. Press <TAB> to move the cursor to the Primary Phone Number field.  Type 914-267-3500. 
 
8. Press <TAB> to move the cursor to the Street Address field.  Type 60 North Harrison Ave Suite 

40. 
 
9. Press <TAB> to move the cursor to the Alternate Phone Number field.  Type 800-722-6374. 
 
10. Press <TAB> to move the cursor to the City field.  Type Congers. 
 
11. Press <TAB> to move the cursor to the State field.  Type NY. 
 
12. Press <TAB> to move the cursor to the Zip Code field.  Type 10920. 
 
13. Click on the arrow next to the Discount Level field and choose B. 
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14. Click on Save.  You have just added a customer with only the basic customer information.  You may 
need to enter the information in other fields later on down the road.  NOTE:  CRE does not require 
you to enter customers.  The default will always be Cash Customer. 

Process a Cash Transaction 
 

Processing a cash transaction involves selecting the customer who wishes to make a purchase and finding 
the item that the customer wants to purchase. 
 
To select a customer (Chapter 3: Customer Control): 
 
1. There is a group of buttons under the heading Customer Info (Modern) and Current Customer 

(Traditional).  These buttons are Find, Quick Search, and More Info.  These buttons are shown 
below: 

 
Modern 

 

 
 

Traditional 
 

 
 
2. Clicking on Find will take you to the Customer Maintenance screen. 
 
3. To find the customer that you want, click on the Next button until the desired customer is on the 

screen. 
 
4. Once the desired customer is on the screen, click on Select.  You will see the customer information in 

the window to the left of the Find button. 
 
5. You can also select a customer using Quick Search if you know the customer’s Customer Number.  

Click on Quick Search, enter the customer number, and then click on OK.  The customer 
information will appear in the window to the left of the Find button. 

 
6. Click on More Info to display the complete customer information (Traditional). 
 
7. Next, we need to find the inventory that the customer wishes to purchase.  There is another area 

entitled Item Search.  This is where we choose the item and the quantity to be purchased. 
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To choose an inventory item: 
 
1. Click on the down arrow in the Search by Item Number/Name area.  A list with all of the inventory 

items should drop down.  Double click on the desired item.  You can also scan in the item number or 
enter it in by hand. 

 
Modern 

 

 
 

Traditional 
 
 

2. The item will appear in the invoice grid. 
 
3. You may change the quantity for an item once it has been added to the invoice grid.  In the Modern 

Invoice Screen, position the cursor on the desired item then click on Quan Change.  In the 
Traditional Invoice Screen, position the cursor on the desired quantity then press <BACKSPACE>.  
Enter the correct quantity once the prompt appears, then press <ENTER> or click on OK, or click on 
Cancel to exit without changing the quantity. 

 
4. You may change the price for an item once it has been added to the invoice grid.  In the Modern 

Invoice Screen, position the cursor on the desired item then click on Price Change.  In the 
Traditional Invoice Screen, position the cursor on the desired price then press <BACKSPACE>.  
Enter the correct price once the prompt appear, then press <ENTER> or click on OK, or click on 
Cancel to exit without changing the price. 

 
5. Click on End Transaction.  You will be prompted to enter the amount tendered.  Enter the amount 

tendered if it is different than the amount displayed, and then click on OK.   
 
6. A window will appear displaying the change for the customer.  Click on OK when you are finished. 

You have just processed a cash invoice. 
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Shortcut Keys 
 
These shortcut keys only work from the main Cash Register Express invoice screen.  If any control has an 
underscore (_) under a letter, that option can be activated by pressing <ALT> + <LETTER WITH 
UNDERSCORE>.  For example, the menu command Exit can be activated by clicking on Exit or by 
pressing <ALT–X>. 
 
 
Modern 
 
 
Cashier Functions 
Clock In/Out 
Customer Maintenance 
Delete Item 
Discount – Invoice Discount 
Help – Invoice Screen Help 
Inventory Maintenance 
Inventory – Toggle Item Search 
Invoice – Hold Invoice 
Invoice – Void Invoice 
Invoice Properties 
Item Options 
Non-Inventory Item 
Payment – Cash 
Payment – Check 
Payment – Credit Card 
Payment – On Account 
Price Check 

 
<F10> 
<F3> 
<F4> 
<CTRL-DEL> 
<CTRL-L> 
<F1> 
<F2> 
<SHIFT-F2> 
<CTRL-H> 
<CTRL-V> 
<F11> 
<F12> 
<CTRL-N> 
<F6> 
<F7> 
<F8> 
<F9> 
<F5> 
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Traditional 
 

 
 

Customer Maintenance 
Customer – Look Up Customer 
Daily Gross Profits 
Department Maintenance 
Discount – Invoice Discount 
Discount – Line Discount 
Help – Invoice Screen Help 
Inventory Maintenance 
Inventory/Kit Sort Order – Sort by Item Name 
Inventory/Kit Sort Order – Sort by Item Number 
Invoice – Invoice Notes 
Invoice – View Line Info 
Invoice – Void This Invoice 
Kit Maintenance 
Non-Inventory Item 
Payment – Cash 
Payment – Check 
Payment – Credit Card 
Payment – On Account 
Price Check 
Purchase Orders 
Return Rentals 
Sales Information – Last Invoice Processed 
Sales Information – Print Last Invoice Processed 
Select Invoice Grid 
Tax – No Tax This Order 
Tax – Tax This Order 
 

<F4> 
<CTRL–U> 
<SHIFT–F1> 
<F3> 
<CTRL–D> 
<CTRL–L> 
<F1> 
<F2> 
<SHIFT–F7> 
<SHIFT–F8> 
<CTRL–T> 
<CTRL–I> 
<CTRL–V> 
<SHIFT–F3> 
<CTRL–N> 
<F6> 
<F7> 
<F8> 
<F9> 
<F5> 
<CTRL-P> 
<CTRL–F1> 
<CTRL–F8> 
<SHIFT–CTRL–F8> 
<CTRL–G> 
<CTRL–X> 
<CTRL–O> 
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Common Questions and Answers 
 

Q: I’m running Cash Register Express on a fast computer.  Why does it take so long to add an item 
to my invoice? 
 
A: The most efficient retail store will have an item number label on every item in the store.  Your 
Inventory Sort Order should be set to Sort By Item Number in the Inventory menu, and Bar Codes 
should be set to Enabled in the Inventory menu.  As long as you know the item number and the above 
two parameters are set, you should be able to have instant lookup by either typing in the item number or 
scanning in the items’ bar codes from the Search by Item Number box. 
 
 
Q: I often get messages that I should register within the next 100 invoices, but I never got around to 
it.  Now I get a message that says the 200 invoice limit was exceeded and I can no longer get into 
Cash Register Express.  What do I do now? 
 
A: Call your dealer.  They will help you on the proper registration process. 
 
 
Q: I often get messages that SHARE.EXE is not loaded properly but I installed it before I ran the 
program.  Why do I still get this message? 
 
A: SHARE may not have been installed properly.  SHARE must be specified in either your 
AUTOEXEC.BAT or CONFIG.SYS files, but not both.  Make sure to use the proper spelling and 
specify the proper directory.  The most common way to load SHARE is to put the following line in your 
AUTOEXEC.BAT: C:\DOS\SHARE.EXE /L:500.  You do not need SHARE if you are using Windows 
for Workgroups or Windows 95. 
 
 
Q: I am using a barcode reader or wand.  When I scan the barcode, either no numbers show up or 
not all the numbers show up.  Why is this happening? 
 
A: Your barcode reader or wand is probably not set up correctly.  To test this, try scanning a barcode in 
DOS or in a simple program such as Microsoft Notepad.  If the numbers on your barcode are not 
showing up correctly, your barcode reader or wand is not set up properly.  Check the manual of your input 
device for help with setting up your barcode reader or wand. 
 
Q: I accidentally added the wrong item onto an invoice.  How do I get this item off of the invoice? 
 
A: Press <CTRL–G> to set the focus to your invoice grid.  Use the arrow keys to move the box onto the 
line of the item you would like to delete from your invoice.  Press <CTRL–DELETE> to delete the item 
from your invoice. 
 
 
Q: My customer bought something and now wants to return his purchase.  How do I do this? 
 
A: To do a return in CRE, all you have to do is create a new invoice in which you add the items to the 
invoice with a negative quantity.  For example, if a customer bought two boxes of diskettes from you, you 
would add –2 boxes of diskettes to the invoice.  CRE will automatically take money out of your profits and 
update the quantity. 
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Q: I get a message stating the Database has been corrupted when starting Cash Register Express.  
How do I fix this? 
 
A: Your database may have been corrupted for a number of reasons.  Perhaps you had a power outage, or 
maybe you turned off your computer before exiting CRE.  The way to fix your database is to select Repair 
Database from the Utility menu in the Log-in Screen. 
 
Q: Why can’t I enter departments in the Inventory screen? 
 
A: You must enter your departments in the Department Maintenance screen and then they will be made 
available for selection from the Inventory Maintenance screen. 
 
 
Q: What is the ****non-inventory**** item for and can I delete it? 
 
A: No, you should not delete it or modify it.  You will need this item in your inventory in order to add 
Non-Inventory items to your invoice.  If this item is delete, the Non-Inventory feature will not work 
properly. 
 
 
Q: Which printer driver should I use for my receipt printer? 
 
A: Generic/Text Only is the required printer driver and is included with Windows.  It can be set from the 
Set Default Printer option from the Setup menu of the Main Invoice Screen. 
 
 
Q: How can I enter additional Cashier IDs? 
 
A: To add a Cashier ID, select Employee Maintenance from the File menu in the Log-In Screen.  You 
will be prompted to enter the administrator’s password.  Click on Add or press <ALT-A>. Enter the new 
Cashier ID and the employee’s information.  When you are finished, click on Done or press <ALT-D>.  
To quit without adding a Cashier ID, click on Cancel or press <ALT-C>.  NOTE: Cashier IDs must be 
two characters long.  The default password for new cashiers is Cashier.  You may change this password 
in Employee Maintenance or by selecting Change Password in the File menu. 
 
 
Q: Where does Cash Register Express store all of my information? 
 
A: All of your information (invoices, customers, vendors, inventory, etc.) is stored in one Microsoft 
Access-compatible file.  The file is labeled CRE2000.MDB.  It is stored within the DATA2000 
subdirectory of the CRE2000 main directory. 
 
 
Q: Why can’t I delete inventory items? 
 
A: If an inventory item has never been used in a past invoice, you are free to delete it.  However, if an item 
has been used in a past invoice, you cannot delete it.  An extra few items will not take up space or slow 
you down in any way.  Also, if you are trying to get a detailed sales history, it is important that all the 
proper information is there to recall when it is needed.  If the item were deleted, you could not get an 
accurate report. 
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Cash Drawer Test 
 

Testing a Cash Drawer Connected to a Star Parallel Printer 
 
1. Go to the DOS prompt (C:\) 
 
2. Type COPY CON LPT1:   <ENTER> 
 
Type A   <ENTER> 
 
Type <CTRL> Z <ENTER>  (Your cash drawer will open) 
 
An Alternate Test: 
 
1. Go into your DOS directory (for example, DOS, CD\DOS) 
 
2. Go into QBASIC (Type QBASIC  <ENTER>) 
 
3. Press <ESC> to clear the QBASIC screen. 
 
4. Enter the following simple QBASIC program: 
 
OPEN “LPT1” FOR OUTPUT AS #1:PRINT #1,CHR$(7):CLOSE 
 
For Epson (TM300 ONLY) use OPEN “LPT1” FOR OUTPUT AS #1:PRINT  
#1,CHR$(&H1B);”p”;CHR$(0);CHR$(25);CHR$(250); 
 
5. Press <SHIFT – F5> to run your program.  Your drawer should open now. 
 
6. Press any key to continue. 
 
7. Repeat step 5 as often as you want to test your cash drawer. 
 
8. Press <ALT – X> to leave QBASIC and return to DOS. 
 
 
Testing a Cash Drawer Connected to a Serial Port 
 
1. Go to the DOS prompt (C:\). 
 
2. Type MODE COM1:300,N,8,1  <ENTER> 
 
Type COPY CON COM1:  <ENTER> 
 
Type A  <ENTER> 
 
Type <CTRL> Z <ENTER>  (Your cash drawer will open) 
 
* Type MODE COM2:300,N,8,1  <ENTER> if you are using COM2. 
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Logic Controls Pole Display Test 
 

The following test sequence will verify that your pole display is properly working.  Before you start the 
following procedure, you must install the pole display correctly as outlined in the Pole Display manual.  
This test procedure assumes that the pole display is plugged into the COM1 port of your computer. 
 
If COM2 is used, substitute COM2 for COM1 in Step 2. 
 
1. Go to the DOS prompt (C:\). 
 
2. Type MODE COM1 96,N,8,2 <ENTER> 
 
Type TYPE CON>COM1  <ENTER> 
 
Type “ABCDEFGHIJKLMNOPQRS” <ENTER> 
 
If the following characters are shown on the display, your pole is working: 
 
ABCDEFGHIJKLMNOPQRS 
 
_ 
 
3. Type <CTRL – C> to return the computer back to the normal display mode. 
 
 
If you are using Windows 95 or Windows 98, your communication port settings should match the 
following: 
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After changing the settings, Windows 95 or Windows 98 may prompt you to reboot your computer. 
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Mailing Labels 

 
 

Mailing Labels allows you to print a label for each customer that you have set up.  To use this function, 
select Programs from the Start Menu, select CRE2000, and then select Mailing Labels. 
 
To print labels: 
 
? ? Click on Select Your Database or press <ALT–E>, and then select the CRE2000 database file. 
 
? ? Select the proper label format in the Labels Per Page field. 
 
? ? Specify the destination as either a printer or the screen in the Print Destination field. 
 
? ? Choose for whom you wish to print labels (All Customers, Certain Customers, or One Specific   

Customer) in the Customer Selection field. 
 
? ? Once you have made all your selections, click on Start or press <ALT–S>. 
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Installation Notes: 
Using WinZip to Unzip a Zipped Version of 

CRE 
 
 
The following are instructions on how to install a zipped version of Cash Register Express.  The 
instructions are assuming that you already have WinZip installed on your computer.  If you don’t have 
WinZip, you can download it from the Download page on the PC America web site.  The address is 
http:\\www.pcamerica.com. 
 
1. Open the folder where the zipped file is. 
 
2. Double-click on the icon of the zipped file.  A screen will appear and you will be prompted to enter 
where you wish to unzip the file.  You should unzip to the default folder unless that particular directory is 
located on a different drive.  For example, if your CRE2000 directory is located on your D drive, type 
d:\cre2000.  It is recommended that you only change the drive, not the name of the directory 
 

 
3. Click on Unzip once you have specified the destination folder.  WinZip will unzip the selected file to 
the designated folder.   
 
4. Once the file has been unzipped, WinZip will display a message stating that the file was extracted 
successfully.  Click on OK or press <ENTER>. 
 
5. Click on Close to exit WinZip. 
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Troubleshooting 
 
 

Error 5 Illegal Function Call – Accounts Receivable Section.  The Balance due does not equal the total of 
the invoices in the Accounts Receivable Section.  A possible remedy is to change the balance due in 
Microsoft Access to the correct amount or to do a Balance Adjustment in the General screen. 
 
Error 7 Out of Memory.  Exit Cash Register Express and close down all other applications that are 
running in Windows.  Then, restart Cash Register Express. 
 
Error 13 This error often occurs when ending transactions using Discount Level Pricing.  One possible 
explanation for this error is that the pole display is causing the error when the COM port is disabled.  This 
error could also occur due to the international settings of a computer.  Check the international settings for 
things like a period not really being a period. 
 
Error 48 Error Loading DLL. 
 
Error 57 Device I/O Error.  Check to see that your Pole Display, Cash Drawer, and/or Printer are 
properly connected.  If you are not using these peripherals, be sure that No is selected for this devices in 
the Setup screen.  Another possible reason this error would occur is that the cash drawer is set to COM1 
rather than LPT1 when using a cash/Star 212 parallel combination.  The reason this error would occur is 
that CRE tried to send a signal to the COM port but there was no device connected to it. 
 
Error 75 This error can occur for a number of reasons: 
 

1. First, verify that the database file location is correct.  You can check this with Setup File 
Locations.  The default is C:\CRE2000\DATA2000.  If the location is correct, then check to see 
if the files CRE2000.MDBand CRE2000.LDB actually reside in the C:\CRE2000\DATA2000 
directory. 

 
2. Check that the files CRE2000.MDB and CRE2000.LDB exist.  If they don’t, delete the 

subdirectory \DATA2000 and the file CREDBL.PCA and re-run Cash Register Express. 
 

3. The file server may be shared as read only instead of full access. 
 
Error 76 Path Not Found.  This error can occur for a number of reasons: 
 

1. Check that the directory \WINDOWS exists on the drive that contains Windows.  If not, create a 
new directory called WINDOWS. 

 
2. This error usually occurs when CRE can’t find the database.  Use Setup File Locations to make 

sure that you are specifying the correct location of the database. 
 
Error 91 This error involves Cash Register Express – Network Version and could be a possible Sharing 
Violation.  You may have more than one computer on the network and did not assign each a separate 
Station ID.  Another possible reason for this error is if you upgraded from an earlier version and you 
conducted the automatic conversion with backing up the database and compacting it. 
 
Error 94 There is a null (blank) value in your information somewhere.  If, for example, you get this in the 
Vendors screen, review your entries to make sure that you are not missing any required values.  Also, it is 
important to check that there is no punctuation in certain fields because this will also cause this error. 
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Error 340 Invalid Property Value.  This error often occurs in Bar Code Express.  Try changing the font 
names in the design label screen to a more standard format. 
Error 482 Printer error.  This error indicates that there is a problem that prevents printing.  Some 
possible causes are that you have selected the wrong default printer or none at all, your printer is not 
online, or your printer is jammed or out of paper. 
 
Error 3000 This error can occur for a number of reasons: 
 

1. Cash Register Express is currently in use by another user or session.  You need to close down the 
other session before beginning a new one.  Or, the database file may be currently in use by 
Microsoft Access. 

 
2. Undefined Access Error.  This error can usually be fixed by running the Compact & Repair 

Database utility.  If you get an error 3000 while repairing, try rebooting the computer first. 
 
Error 3008 Cash Register Express still loaded in memory.  This error usually occurs when you are trying 
to convert your database.  Rebooting your computer will usually solve this problem. 
 
Error 3018 You are missing a data field.  This error is most likely caused if you have upgraded to a 
newer version of CRE and have not used the Conversion Utility.  You can run the Conversion Utility by 
selecting Conversion Utility from the CRE2000 folder in the Windows Start Menu. 
 
Error 3021 No current record.  Try repairing and compacting your database. 
 
Error 3022 Duplicate key.  This error occurs when you are trying to create an item (such as a customer, 
inventory item, kit, invoice, etc.) with a duplicate value of the indexed filed.  (Example: duplicate 
customer number, item number, invoice number, etc.). 
 
Error 3037 See error 7. 
 
Error 3040 Disk I/O error.  When this error is followed by error 91, repair your database.  Repairing the 
database should correct this error. 
 
Error 3041 Incompatible Database Version.  Try renaming the file VBDB300.DLL in your 
C:\WINDOWS\SYSTEMdirectory to VBDB300.OLD and reinstall Cash Register Express. 
 
Error 3044 Data file not found.  This error usually occurs when CRE cannot locate the database.  Use 
Setup File Locations to make sure that you are specifying the correct location of the database. 
 
Error 3049 The database file has been corrupted.  This error is usually a result of a power failure or 
turning off your computer before exiting CRE or Windows.  You can repair your database by using 
Compact & Repair Database. 
 
Error 3075 Invalid characters in item.  This error usually occurs when an apostrophe (‘), pound sign (#), 
asterisk (*), or ampersand (&) appears in an item name or item number.  Try changing the problem item 
then reprocess the invoice. 
 
Error 3077 Error occurs when searching for an item.  An item in the inventory may have a quotation or 
some other punctuation mark in its item name or item number.  Try re-entering the item in the inventory 
without using any punctuation. 
 
Error 3078 Couldn’t find a table.  See error 3049. 
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Error 3163 Data too long to be entered into the database.  This error usually occurs with non-inventory 
items.  The item description may contain too many characters.  Try shortening the description. 
 
Error 3167 Record already deleted.  The error occurs because CRE is trying to access a deleted item.  To 
fix this, run Compact & Repair Database and Backup Database. 
 
Error 3183 Not enough space on temporary disk.  Free up hard drive space by deleting unwanted or 
unnecessary files and/or directories. 
 
Error 3196 CRE is currently in use by another user or session.  You must close down the other session 
before beginning a new one. 
 
Error 3197 Corrupted database.  Run Compact & Repair Database. 
 
Error 3356 Currently locked by another user. When repairing database, make sure that all other stations 
are turned off before attempting repair database, then try to repair database while all other computers are 
turned off. 
 
Error 20504 Crystal Report *.RPT file not found.  This error occurred because you are missing one of the 
crystal report files in your install directory.  Reinstall CRE to fix this problem. 
 
Error 20525 Unable to load report.  This error means that there is some error in loading the report 
because the report is probably corrupted.  Reinstall CRE to fix this problem. 
 
Error 20526 This error occurs if you are printing a report and have not yet specified a default printer.  
Specify a default printer by selecting Set Default Printer from the Setup menu in the Main Invoice 
Screen. 
 
Error 20529 This error usually occurs when trying to print reports.  This error indicates that your hard 
disk is full and there is not enough space to either load or export the report data.  Try freeing up some 
hard disk space. 
 
Error 20533 Unable to open database file within Crystal Report.  Contact PC America with the report you 
are trying to run.  Crystal sometimes generates this error when the database structure has changed, so it 
has to be updated. 
 
Error 20534 Error in Crystal Report DLL.  This error occurs when one of the DLL file is corrupted.  You 
should rename it and then reinstall CRE to replace the corrupt file.  Check for DLL files with wrong 
dates, times, and/or sizes (especially with a size zero). 
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Technical Support 
 
 
If you have any problems or questions and you cannot find the answers in the help section or in the 
manual, PC America will be happy to give you technical support. 
 
Technical support is FREE for 90 days after your purchase.   Including upgrades, Technical Support is 
$300 (single user) or $499 (multi user) per year after your initial free period. Technical support is 
available 9 am to 6:00 pm EST Monday through Friday.  24 Hour Technical Support Contracts are 
available for an additional $395 per year.  24 Hour Technical Support Contracts must be arranged at least 
one week prior to usage. 
 
CRE software upgrades are available from the Internet at http://www.pcamerica.com.  Call Technical 
Support or your sales person to get the necessary password for any upgrade.  All upgrades require WinZip.  
If you do not have WinZip, it is also available on the PC America web page.  Upgrades are also available 
on CD for $10 plus the appropriate shipping charge.  Additional or new copies of the manual are available 
for $25 each. 
 
We also welcome any comments or suggestions about our software.  You can reach our technical support 
representatives at: 
 
Voice: 845-267-3549 
 
Fax: 845-267-3550 
 
Mail: PC America 
 Attn: Technical Support 
 60 North Harrison Avenue 
 Suite 40 
 Congers, NY 10920 
 
If you are faxing or mailing any questions, comments, or suggestions to us, please include your name, 
phone, and/or fax number, the name of the company that you own or for which you work, the name and 
version of the program you are using, and a detailed explanation of your questions or comments so we can 
help you most effectively. 



 

 

CASH REGISTER EXPRESS 8.xx SUPPORT OPTIONS   

 

NEW Cash Register Express 8.xx Update. The new 8.0 Update is available NOW. The 8.xx Update is FREE on 
the internet if you purchased Cash Register Express within the last 90 days. If you purchased Cash Register Express 
or technical support within the past 12 months, a partial credit is available towards the purchase of updates and 
technical support options below. 

New Cash Register Express owners receive 90 days of FREE Technical Support and Updates. 

Please choose a technical support plan below and fax your technical support contract back to 845-267-3550. 

??1 Year Single User Upgrades and Incoming Technical Support ($300).  Technical support contract includes 
10 incoming telephone calls (you call us) or a maximum of 120 minutes (whichever comes first). Technical 
support is available 9 AM – 6 PM EST, M-F by calling 845-267-3549.  

??1 Year Multiuser (2-5 stations) Upgrades and Incoming Technical Support ($499). Technical support 
contract includes 10 incoming telephone calls (you call us) or a maximum of 120 minutes (whichever comes 
first). Technical support is available 9 AM – 6 PM EST, M-F by calling 845-267-3549. Add $100 per station 
for updates and technical support for each station above 5 users.  

??Add $100 for Outgoing Technical Support. Call PC America at 1-800-PC-AMERICA or 1-800-722-6374 
X502 and receive a callback within 3 business hours available 9 AM – 6 PM EST. 

??Add $395 to any of the above contracts for 24 Hour Extended Technical Support. Technical support 
contract includes up to 10 telephone calls including 5 emergency incidents up to 120 minutes. If your system is 
down, this is considered an emergency incident. Standard technical support is available 9 AM – 6 PM EST, M-
F. Emergency technical support is available 24 hours per day by calling 1-800-PC-AMERICA or 1-800-722-
6374, choosing option 3 and leaving an emergency message. A technical support person will be paged a call you 
back (limited to U.S.A. 50 states). 

 

Name on Credit Card  ___________________________________________________________________ 

Company Name  _______________________________________________________________________ 

Street Address  ________________________________________________________________________ 

City, State and Zip Code  ________________________________________________________________ 

Credit Card Number  ___________________________________________________________________ 

Credit Card Expiration Date  ___________________________  Today’s Date ______________________ 

Signature _____________________________________________________________________________ 



 

 

PC America Technical Support Frequently Asked Questions 

 

??Busy Signals when calling for technical support. Our technical support lines are free at least 40% of the day 
between 9 AM and 6 PM, EST, M-F. We do not place callers in a queue to wait for the next available support 
person. If you get a busy line, keep trying. Most callers can use *66 on their telephone to automatically keep 
calling until the line is not busy… .or, try one of the tech support alternatives listed below. 

??Live Online Support. You can now reach the technical support department live 9 AM – 6 PM, EST, M-F by 
using America Online Instant Messenger (AIM). You do not need America Online to use this service. Anyone 
with Internet Access can use AIM free of charge. Go to www.aol.com and download America Online Instant 
Messenger. Our online chat name is POSNOW. 

??Support Via Email. You can get support at no charge by writing to posnow@aol.com. This email address is 
monitors 3 times per day, 5 days per week. You will normally receive a reply the same day. 

??Support on the Internet. Any question you may have, has probably been answered already. Prior to calling, 
you should try looking at our support page at www.pcamerica.com. 

??Network Problems. If you have two or more computers connected via a network and you did not purchase your 
Network from PC America, we cannot support your network at no charge. Our technician will ask you to 
confirm that your network is working by using Network Neighborhood to test your connection. If you network is 
not connected, you must seek help from the person who installed your network… or, PC America can help you 
get your network working via a $99 Network surcharge. 

??Other Hardware Problems. If you purchased your hardware from a company other than PC America, we 
cannot give you hardware support at no charge. We have methods of testing most of your hardware. If you 
hardware is working properly, we will support your hardware with CRE2000. If your hardware is not working 
properly, you must go back to your original hardware supplier for support or pay a surcharge for support from 
PC America. The most frequent problems we find with hardware are serial port conflicts with modems and 
modem software and printer conflicts with certain printers which have software that takes over the parallel port. 

??IC Verify Credit Card Processor Problems. If you have purchased IC Verify from PC America or any other 
source, you must first get IC Verify to work all by itself, independent of CRE2000. To get support with IC 
Verity, you must call Cybercash for assistance. The phone number is in your IC Verify Manual). If you want 
PC America to help you to get IC Verify to work, there is a $99 tech support surcharge. Most problems related 
to IC Verify are caused by having the wrong bank credit card phone number for processing, incorrect modem 
strings (which can be reset automatically within IC Verify), conflict with fax software, or use of the wrong serial 
port. Once you have IC Verify working independently, we can help you to get it to work properly with CRE2000 
(or just look in the manual).  

??Upgrades. Upgrades to a new version are $300 Single User and $495 Multiuser. Upgrades through the Internet 
are FREE with selected technical support contracts when purchased within 30 days of the expiration date of 
your tech support contract. 

 


